
 

 
 
 
 
 
 
 
 

WAVEWIN 
FILE MANAGER 
& ANALYSIS 

 
 
 
 
 
 
 
 

QUICK START 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
SOFTSTUF, INC. 

SOFTWARE STRUCTURE FOR UNLIMITED FUNCTIONALITY 
P.O. BOX 40245 

PHILADELPHIA, PA 19106-0245 
1-800-818-3463 · 215-922-6880 

www.softstuf.com  
www.wavewin.net  

http://www.softstuf.com/
http://www.wavewin.net/


 

 
Copyright © by Softstuf, Inc. 
All rights reserved. 
Printed in the United States of America. 
 
Last Update: August 2024 
 
Acknowledgments 
 
Wavewin is a registered Trademark ® of Softstuf Incorporated. 
Windows is a registered Trademark of Microsoft Corporation. 
All other products and brand names are trademarks or registered trademarks of their respective holders. 



 

Preface 
 
This document contains information about the Wavewin file management and Analysis capabilities. The 
document also describes the numerous display drivers provided. 
 
This document is intended for use by individuals working in protection, engineering, and system operations.
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System Requirements & Installation 
 
This chapter lists the system requirements needed for installing and running the Wavewin software. It also 
describes the installation procedures and provides technical support information. 

System Requirements 

The system requirements are listed below. 
 
 An IBM or compatible PC with an 80486 microprocessor or higher. 
 500 Megabytes of memory. 
 2 gigabytes of available hard disk space. 
 Microsoft Windows version XP or higher. 

Installation 
The system files are distributed in a compressed format. To install the software, follow the instructions for 
the type of storage media distributed with this manual. 
 
Web: To install the software from the Web, access the www.wavewin.net web site. Under the “Wavewin 
Upgrades” link click on the Wavewin application to download. Enter your username and password to get 
access to the download page. The username and password are case sensitive. Click on the software link to 
download the latest system’s zip file. Unzip the contents of the downloaded zip file to a directory off the 
computer’s root drive, c:\Wavewin32.  
 
USB: To install the software using a USB drive, place the USB drive into the USB port. Navigate to the 
installed drive using Windows Explorer and copy all the files to a directory off the computer’s root drive, 
c:\Wavewin32. 
 
The installation is now complete. 

Starting the Software 

After you have installed the software on your computer, you are ready to begin. How you begin depends on 
your own style. If you like to dive right in and learn by doing the system provides on-line help to assist you. If 
you prefer a structured learning approach, read the quick start chapters to get familiar with the software. 
 
To run the software, navigate to the Wavewin install path and double click on the Wavewin32 shortcut.  

Technical Support 
Although this system is easy to use and understand, at some point you may encounter a technical question, 
feel that the system has improperly operated, or have suggestions for future improvements. In either case, 
contact Softstuf using one of the following methods: 
 
Phone:  800-818-3463, 215-922-6880, hours are from 9:00 a.m. to 6:00 p.m. Mon- Fri, (EST). 
E-mail:  support@softstuf.com, response time 24 hours.

http://www.wavewin.net/
mailto:support@softstuf.com
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File Manager Quick Start 
 
This chapter describes the main features of the File Manager. 

File Manager Features 
The File Manager is used to manage files on disk, search the contents of a drive or directory, and edit, plot, 
or draw the contents of a file. This feature is similar to Windows Explorer with application specific functions 
tailored for the Power Utility Industry. The functions include automatic event file association, specialized 
copy/move engines, intelligent queries, specialized report files, COMTRADE conversion and compression 
routines, merge and append waveform and load files, event summaries, and calibration reports. 
 

 
Figure 2.1  File Manager 

 
When the software is activated, the File Manager displays the subdirectories and files of the last active drive 
and directory. This window consists of a folder tree, file table and a query bar. The query bar is located 
below the table. The main features are described in the following sections. 

LONG FILE NAMING FORMAT (COMNAMES) 
The File Manager supports the IEEE long file naming format C37.232. The IEEE long file naming format is 
a PSRC format used to name time sequenced data files. The file table columns are used to display the 
contents of the long file names. The file name contains the first ten fields stored in a comma-delimited 
fashion. The remaining fields are optional. The file table lists four optional columns at the end of the table 
to support user defined fields. The ComNames properties dialog allows for user input for the first two 
optional fields. 
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Example:  000112,123433234,-5S,South Arkey,DLP1,Sun Power,,123.22,+34.6,AG T.OCS 
 
Field Definitions: 
 

Field Example Displayed Definition 
Date 000112 01/12/2000 The Date field defines the start date of the file. 

The date fields are defined as: the first two 
characters are the year, the next two are the 
month and the last two are the day. (required)  

Time 123433234 12:34:33.234 The time field defines the start time of the file. The 
Time fields are defined as: the first two characters 
are the hour, the next two are the minutes, the 
next two are the seconds and the last two or three 
are the milliseconds. (required)  

Tcode -5S -5S The TCode field is the time offset from GMT time.  
If the start time is expressed in UT, this field is 
coded 0z,  
Note: GMT is the international abbreviation 
Greenwich Mean Time. (required)  

Substation South 
Arkey 

South Arkey The substation name or code where the 
originating device is located. (required)  

Device DLP1 DLP1 The device name or code that generated the file. 
(required)  

Company Sun Power Sun Power The company of the specifed substation. 
(required)  

File Tag T T The fault type or contents type of the file. 
(optional)  

Line 
Length 

123.22 123.22 The line length extracted from the event file. This 
field applies to certain relays. (optional)  

Fault 
Location 

+34.60 +34.60 The fault location extracted from the event file. 
This field applies to certain relays. (optional)  

Fault Type AG T AG T The fault type extracted from the event file. This 
field applies to certain relays. (optional)  

COMNAME(S) RENAME 
To rename time sequenced data files using the IEEE long file naming format select the ComName(s) 
Rename icon under the File tab. ComName(s) Rename will rename all the marked waveform files to the 
IEEE PSRC long file naming format. A message box will be prompted before renaming the file to ensure 
the execution of the rename feature. This feature will permanently rename the files. It is advisable to back 
up the files before renaming. Some proprietary applications may not be able to read the files once they are 
renamed. For a full description of the format refer to the Long File Naming Format. 
 
For specific display driver’s, information from the file is placed in the long file names. 
 

• SEL Files: The user fields have the Line Length, Fault Location, and the Event Type (example type 
field: ",100, 86.0, CG T"). 

• DLP Files: The user fields have the Fault Type, Distance and Trip Type in the type field (example 
type field: ",AG 001.8 PLT,"). 

• Transcan Files: The 1st User Field has the 4-character station ID (example user field: ",BEDG,"). 
• Rochester Files: The 1st User Field has the 5-character header name (example user field: 

",20626,"). 
• Hathaway Files: The #DAU ID data is added next to the device name (example device field: ",DAU 

8#8,") 
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All files associated with the marked files will also be renamed.  
• Comtrade files: the ".CFG", ".INF", ".HDR", ".DAT" and "*.D##" files will be renamed. 
• Faxtrax files: the ".CTL", ".RCD", ".RCL", ".RCU" and ".RCS" files will be renamed. 
• Rochester files: the ".PRE" file and all files with the same name and a ".###" extension will be 

renamed. 
 

 
Figure 2.2  ComNames Rename: Select and Mark all the Waveform Files to Rename 
 

 
Figure 2.3  ComNames Rename: Result 

COMNAME PROPERTIES 
The fields defined in the IEEE long file naming format are not always available from the time sequenced 
files. The ComNames Properties dialog allows for setting the most common fields not available in the time 
sequenced files. To open the ComName Properties dialog select the ComName Prop icon located in the 
File tab. User fields allow for setting specific information into the file name. 
 

• Company Name 
• Time Code 
• User Field 1 
• User Field 2 

 
The fields entered are used for all files renamed. 
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Figure 2.4  ComName Properties Dialog 

COMMAND LINE PARAMETERS 
Command line parameters are supported in the Wavewin software. The listed command line parameters 
are specific for the file manager and data plotting. Below is a list of all supported command line 
parameters and their descriptions: 

 
Command Line Description 

Path and Filename If a path and filename is passed as a command line parameter the 
path and filename must be surrounded by quotes, such as 
“c:\faultlibrary\event1.dat”. Wavewin will automatically open and 
display the file. Only the file is opened in Wavewin. To display the file 
manager, click on the File menu button . 

/Print The “/Print” command line parameter is used along with a path and 
filename command line. It automatically opens, displays, and prints 
the file when Wavewin is executed. 

/Comtrade The “/Comtrade” command line parameter is used along with a path 
and filename command line. It automatically converts a file to the 
IEEE C37.111 Comtrade Standard. The passed parameter is 
/Comtrade. To retain the original file name of the source file, use the 
/Comtrade passed parameter. To have the file automatically named 
using the IEEE C37.232 file naming format use the /Comtrade=1 
passed parameter. The /Comtrade command line parameter can also 
be used in batch files. The converted Comtrade files are saved in the 
same directory as the source file. The new passed parameter will 
convert the source file to Comtrade. 
 
Comtrade Commands: 

• /Comtrade - Convert the Specified Files to the ASCII 1999 
format. The original file name is used when naming the 
Comtrade Files. 

• /Comtrade=1 - Convert the Specified Files to the ASCII 1999 
format. The IEEE Long file name is used when naming the 
Comtrade Files. 

• /Comtrade=2 - Convert the Specified Files to the ASCII 
Comtrade Format specified in the Data Plotting Properties 
Dialog under the Comtrade tab. The IEEE Long file name is 
used when naming the Comtrade Files. 

• /Comtrade=3 - Convert the Specified Files to the Binary 
Comtrade Format specified in the Data Plotting Properties 
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Dialog under the Comtrade tab. The IEEE Long file name is 
used when naming the Comtrade Files. 

 
Below are some examples: 
 
Examples: 
------------- 
1.) Passed Parameter: "c:\faultlib\shipdir\SEL-421.CEV" /Comtrade=1 
Comtrade Filename: 011207,145119291000,-5,Station A,Relay 
1,SOFTSTUF,TRIP,,SOTF B_PHASE C_PHASE GROUND 
50,60.00.DAT 
 
2.) Passed Parameter: "c:\faultlib\shipdir\DATA1068.RCD" /Comtrade 
Comtrade Filename: c:\faultlib\shipdir\DATA1068.DAT 

/Batch The “/Batch” command line parameter is used along with a path and 
batch filename command line. It automatically opens the defined 
batch file and executes each command line parameter defined in the 
file. This feature is used mainly to process each file and extract key 
features from each file and save to a comma delimited file or for 
converting a number of files to Comtrade through one command line 
parameter. 

/Merge The “/Merge” command line parameter is used along with a path and 
filename command line. It will merge the file with all files that have a 
/merge command line parameter associated with them. The /merge 
command line parameter is defined in a Merged File.lst ASCII file. 
The Merged File.lst is passed to Wavewin through the command line 
parameters. All files listed in the Merged File.lst are automatically 
merged by time. If the files have different sampling frequencies the 
highest frequency is used. The merged file is saved as an ASCII 
1999 Comtrade file and placed in the same directory where the 
Merge File.lst is located. The Comtrade files are named Merged 
File.cfg and Merged File.dat. If an error occurs a Merged File.log file 
is created listing all errors encountered.  
Example contents of a Merged File.lst: 
 C:\faultlibrary\event10.dat /merge /exit 
 C:\faultlibrary\event12.dat /merge /exit 
 C:\faultlibrary\event14.dat /merge /exit  

Fault Automatically display the Fault Data Manager when Wavewin is ran. 
SOEList Automatically display the SOE List manager when Wavewin is ran. 

/X The “/X” command line parameter tells where to display Wavewin’s 
left corner when executed.  

/Y The “/Y” command line parameter tells where to display Wavewin’s 
upper corner when executed. 

/W The “/W” command line parameter tells the width of the Wavewin 
application when executed. 

/H The “/H” command line parameter tells the height of the Wavewin 
application when executed. 

/Exit The “/Exit” command line will automatically exit Wavewin after all 
other command line parameters are fully complete. 
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NAVIGATING 
 
Files: 
To browse the files in the active directory, use the up, down, right, left, page up, page down, home, 
end, ctrl+home, and ctrl+end keys, or use the scroll bars.  
 
Drives/Directories: 
To view the contents of a folder, navigate through the folder tree or place the cursor on the folder name 
in the file table and press <enter> or double click on the desired folder. The “.” and “..” displayed at the 
top of the file table provide shortcuts to the previous folder and the root directory. To return to the 

previous folder, place the cursor on the “..” shortcut and press <enter> or click the Up  icon or 
press the backspace key. To return to the root folder, place the cursor on the “.” shortcut and press 
<enter>. 
 
To change the active drive letter, click the ChDir  icon or press F7. Enter the drive letter/path and 
click OK. To return to the last active folder, enter only the drive letter. To display the contents of the 
root folder, enter the drive letter, a colon, and a backslash, for example type “C:\”.  An error message is 
displayed if the software cannot find or open the specified folder. 
 

To navigate through the last active folders, click the Back  menu button or click the right mouse 
button to display a list of the connected drives and the last 12 navigated folders. 
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Figure 2.5  Folder Tree 
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Figure 2.6  Drive/Directory Navigation Menu 

FAVORITES BAR 
The Favorites Bar allows for quick access to all your most navigated folders.  
 

 

 
 

 
 
 

 
Figure 2.7  Favorites Bar 

 

Edit the Favorites 
List. 

Save the Active Path 
in the Folder Tree to 
the Favorite List. 

List the Folders in the 
Favorite List in a drop-down 
list box. 
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Figure 2.8  Edit Favorites Bar 

 
The table below details the action for each button in the Manager Favorites dialog. 
  

Button Action 
Move Up Move the selected row up one position. Only one row can be selected at a 

time. 
Move Down Move the selected row down one position. Only one row can be selected at 

a time. 
Add Add a new directory to the list.The microsoft select directory dialog is 

displayed.  
Delete Delete all the directories with a ccheck mark. 
Save Save all the changes. 
Cancel Leave the dialog without saving any of the changes. 

REFRESH THE ACTIVE DIRECTORY 
Click the Refresh  menu button to update the contents of the folder tree and the file table or press F12. 
To refresh only the folder tree right click on the folder tree and select the Refresh option. To refresh only 
the file table right click on the file table and select the Refresh  menu option.  
 

.  
Figure 2.9  Folder Tree Popup Menu 

MARKING FILES 
Files are marked and unmarked through the mark icons in the File tab, the space bar, or the mouse 
button. Use the shift+left mouse button to mark a group of files or the ctrl+left mouse button to randomly 
mark files. Marked files are displayed in red and can be copied (F8), moved (F9), deleted (Delete), 
grouped, sorted, or plotted. 
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SORTING FILES 
The column headers displayed at the top of the table are used to sort all the files in the table. Click the 
header buttons to toggle between ascending and descending order  The active sort field is 
displayed in the status bar at the bottom of the window .  

COPYING OR MOVING FILES 
Files must be marked to copy or move them from the active folder. To copy/move files using the Window’s 

Folder Tree dialog click the Copy To  / Move To  icons or press F8 for copy and F9 for move. Select 
the folder from the Directories tree or click on the New Folder button and enter the new directory then 
press <enter>. A message is displayed if an error occurs while copying or moving the files. The Cancel 
button or the <esc> key terminates the command. 
 

 
Figure 2.10  Copy Dialog 

 
To copy or move files to the clipboard select the Copy/Cut menu options under the Edit menu or right click 
in the file table and select the Copy  or Cut  option from the popup menu. Navigate to the 
destination folder and select the Paste option under the edit menu or the Paste  option from the 
file table’s popup menu.  
 
To move files using the drag and drop feature, first mark the files in the file table then drag them to the 
desired folder in the Folder tree. Once the move is complete, a message box will be displayed listing the 
number of files moved to the selected folder.  
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After a copy/move or paste command is executed and a file is successfully transferred to the destination 
directory, the system's task bar in the upper right-hand corner of the screen is updated. All files that were 
unsuccessfully copied/moved using the Copy/Move features are marked and grouped at the top of the 
table. 
 
The specialized copy/move/paste engine copies the COMTRADE and DFR header and configuration 
information along with the selected data file. For example, when a data file is copied or moved the 
corresponding header information (CFG, HDR, INF, DAU-DEF, SCF File, CTL File and *.PRE files…) are 
automatically copied from the source folder to the destination folder.  

EMAIL FILES 
Files must be marked first (displayed in red) to email. Mark all the files to email then click the Email icon 

 or right click in the file table to display the popup menu and select the Email  option. The 
users default email program is displayed with all marked files in the attachment section. Also, any support 
files needed to display the selected files will be automatically attached. Support files include Comtrade 
.CFG, .HDR and .INF files, Hathaway DAU files, Transcan .SCF and .TCF Files, Faxtrax or Director .CTL 
files and Rochester .PRE, Machine.DAT and Data files. 
 

 
Figure 2.11  Email Dialog 

ZIP FILES 
To zip a group of files first mark the files. Marked files are displayed in red. To zip the marked files  click 
the Zip Files icon under the File tab or right click in the file table to display the popup menu and select the 
Zip  option. The zip dialog is displayed. Enter the filename and folder. Click the Folder  button to 
browse and select a destination folder. If no destination folder is defined, the zip file is saved to the file 
table’s active folder. Also, any support files needed to display the selected files will be automatically 
included in the zip file. Support files include Comtrade .CFG, .HDR and .INF files. The zip files created are 
compatible with Windows and the WinZip application. 
 
The Zip Marked Files dialog allows for entering a password for the zip file. To password protect the zip file 
enter a password in the Password field.  
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Figure 2.12  Zip Dialog 

CUSTOMIZING THE TABLE DISPLAY 
The columns displayed in the table can be repositioned through the Display Properties option under the 
Options menu/tab.  Use the Move Up and Move Down buttons to change the position of a column. The 
table columns can also be resized. Position the mouse over the column separator in the table and drag 
the mouse to the desired location or double click on the table separator to resize the column to the largest 
display. 
 
The size of the font displayed in the table can also be changed. Use the Table Font Size drop down list 
under the General Table Settings tab to select the desired font size. Also, to use the Window’s default file 
marking, select the Windows option from the File Marking drop down list. To mark files with a single 
mouse click select the Single Mouse Click option. 
 
The default path that is displayed when the file manager is first opened is defined in the Default Path field. 
Enter the path or use the Browse button to select the path.  
 
To turn sorting off for the file table select No in the Sort Tables drop-down list box. The default is yes. If a 
large number of files exist in a directory, then the sorting can take an extended amount of time. 
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Figure 2.13  Customize Table Columns 

PRINTING THE FILE TABLE 
The print feature provides two options: print all or marked files in the active directory. To print all the files, 
select the All Rows drop down option under the Print icon in the Files tab. To print the marked files, select 
the Marked Rows drop down option under the Print icon in the Files tab. An error message is displayed if 
the software cannot access the printer port. 

COMPRESSING COMTRADE ASCII FILES 
The File Manager contains a built-in compression routine that converts COMTRADE ASCII files to 
COMTRADE Binary files. To compress COMTRADE ASCII files, mark the files and select Compress icon 
under the Options tab. The software prompts for confirmation, click Yes to continue, or No to cancel. 

SAVE AS 
Oscillography formats supported by the software can be converted to the COMTRADE ASCII or Binary 
format, RMS Values, Instantaneous Values and Vector Values using the Save As icon in the File tab. For 
Comtrade there are three Comtrade versions supported: the older 1991 format, the 1999 format and the 
newest 2013 format. The new 2013 Comtrade format can be saved as a single file with the CFG, HDR 
and DAT all contained in the single file. The new Comtrade single file format has a .CFF extension.  
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The Comtrade format is selected from the Save As Type field’s drop-down list. To create a COMTRADE 
file place the cursor on the event file or mark the desired files and select the Save As icon under the File 
tab. Enter the destination path and filename (do not enter a filename extension) and click OK. The *.CFF 
or “.DAT” and “.CFG” files are automatically assigned. If a path is not defined, the COMTRADE files are 
saved in the active directory in the File Manager. 
 
If the sample values in the selected file(s) are RMS calibrated and the desired Comtrade file must have 
instantaneous values set the Comtrade Settings fields to automatically convert the RMS data to 
instantaneous values. To set the Comtrade Settings fields open the Properties dialog in the analysis 
window. Select the Comtrade tab then select “Yes” for the Convert RMS Calibrated Data to Peak Data 
field. 
 
To automatically save the selected file(s) using the IEEE long file naming format check the “Use the 
ComNames Naming Convention to Name the Comtrade File(s)” field in the “Save As” Dialog and leave the 
File Name field empty. To specify the files to Save select one of the 3 options from the Files section, 
Selected File, All Files in the table or just the Marked files. 
 
The Save As RMS Values, Instantaneous Values and Vector Values saves the values to a comma 
delimited ASCII file. These files can be displayed in the data plotting window or opened in Excel for further 
analysis. 
 
For Comtrade files, if the line impedance values and line length are available in the original file then 
Wavewin will save the line impedance values to the .HDR file/section. Below is an example of the 
information Wavewin saves in the header section of the Comtrade single file (.CFF). 
 
If the file is an SEL file and the settings for the file are included in the original file, then the settings can be 
automatically written to the Comtrade’s .HDR file/section. To have the SEL settings added to the Header 
file/section click the Save SEL Settings checkbox. The system will remember the state of the checkbox.  
 
--- file type: HDR --- 
Fault Information 
01 - Event: BG  Location:    0.90  Shot:    Frequency:  60.03 
     Targets:  
     Currents (A Pri), ABCPGQ:    332  3660   316     2  3596  3580 
     Line Len:  3.08 
 
Impedance Values 
Z1Mag = 2.84 
Z1Ang = 66.65 
Z0Mag = 8.81 
Z0Ang = 68.67 
LL = 3.08 
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Figure 2.14  Save As Dialog 

DISPLAYING OSCILLOGRAPHY RECORDS 
A library of device drivers is used to display various types of oscillography formats. The proprietary 
drivers below are available in the Wavewin Universal Viewer and Full versions only. The Comtrade 
driver is available in all versions. The formats supported by the system are:  
 
COMTRADE ASCII and Binary 
Hathaway DFR I, II, IIB, and 2000  
Emax Faxtrax & Director DFR  
Mehta Transcan DFR  
Rochester TR16**  DFR  
SEL Relays (all series including the compressed format)  
ABB Relays (REL 301/302, MDAR 300, GPU, TPU & DPU 2000R and below) 
ABB Load Profile (Wye-Connected VTs and Delta-Connected VTs) 
GE Relays (DLP1 & DLP3)  
Dranetz SER 
Satec PM295 
RFL 9300 
SDC Log Files 
Fluke Scope Meter 
SEL Load Profile Data 
SEL Sag/Swell/Interruption Files (SSI) 
Ametek TR-100+, DL-8000, TR-2000 & P&QR128 
ERLPhase Tesla 
ERLPhase BPRO, TPRO, LPRO & FPRO 
Emax Long Term Records 
GE-SRSeries 
Hathaway Replay Plus (DFR, TSS & CSS files)  
TIS 
S&C IntelliRupter fault interrupter Waveform  
S&C PXI  
S&C Extended Waveform Capture 
Audio Wave File 
S&C Meter 
S&C Daily High Low File 
Nicolet PNRF  
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Nicolet Power Pro WFT 
Comma Delimited (Time, Channel) format 
SDC Comma Delimited Files 
Audio Wave Files 

 
To plot the contents of a file, place the cursor on the filename and select the appropriate driver from the 
“Driver” menu. A maximum of ten display windows can be opened at one time. Refer to the “Analysis” 
section for more information. 

ASSOCIATING FILE TYPES 
The File Manager automatically associates file types according to the file naming structure and file 
extensions. The associated driver is displayed in the driver column. When the <enter> key is pressed, or 
the default mouse button is double clicked the software inspects the filename at the cursor and executes 
the assigned driver. The Proprietary drivers listed below are available in the Wavewin Universal 
Viewer and Full versions only. Files are associated according to the following parameters: 
 

Driver Association Parameter 
Directories  Directories are tagged according to the parameters read from the file 

allocation table. 
Applications  Files with the extension “.BAT”, “.COM”, or “.EXE” are tagged as application 

files. 
Hathaway DFR I,II, 
IIB & 2000 

Files that match the Hathaway Base32 file naming scheme or are long files 
with the .DFR extension are tagged as DFR I,II, IIB, & 2000 files. 

EMAX Faxtrax II / 
Director  

Filenames with the extensions “.RCD”, “.RCL”, “.RCU”, and there is a 
cooresponding “.CTL” file, are tagged as Faxtrax II / Director files. The Emax 
Faxtrax II / Director (12-bit/16bit) format is supported. 

Mehta Transcan  Files that have an extension starting with “X” and a corresponding “.SCF” file                    
exists are tagged as Mehta Transcan files. 

Rochester TR16**  Files that have the same name and an extension with a number and there is a 
corresponding .PRE file in the same directory are tagged as Rochester files. 

NxtPhase Tesla Files with the extension “.TLR” are tagged as NxtPhase Tesla files. 
COMTRADE  Files with the extension “.DAT” that have a cooresponding “.CFG” file are 

tagged as COMTRADE files. 
SEL   Files with the extensions “.SEL”, “.CEV” or “.EVE” are tagged as SEL files. 

 
SEL LPD Files with the extension “.BSV” are marked as SEL Load Profile Data files 
DLP  Files with the extension “.OSC” are tagged as DLP relays. GE DLP1 and 

DLP3 formats are supported. 
REL300/301/302 Files with the extension “.REL” are tagged as ABB-MDAR files.   

 
TPU/DPU/GPU Files with the extension “.CAP” are tagged as ABB-TPU/DPU/GPU files. 
ABB Load Profile Files with the “.DLA” extension are tagged as ABB Load Profile-Wye files. 
GE SR745/489 File Files with the “.CSV” extension are tagged as GE SR745 Files. 
SDC Log File Files with the “.CSV” extension are tagged as SDC Log Files. 
TIS File Files with the “.TIS” extension are tagged as TIS (Trip Information System) 

Files. 
Ametek Files Files with the “.AMT” extension are tagged as Ametek TR-100+, DL-8000, TR-

2000 & P&QR128 Files. 
NxtPhase Relays 
(BPRO, TPRO, 
LPRO & FPRO) 

Files with the “.BPR, .TPR, .LPR, FPR” extensions are tagged as NxtPhase 
Relay Files. 

Emax Long Term Files with the “.DAT” extension with an associated “.SET” file are tagged as 
Emax Long Term Files. 

Hathaway Replay Files with the “.DAT” extension with no “.CFG” associated with it are tagged 
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Driver Association Parameter 
Plus as Hathaway Replay Plus Files. 
S&C IntelliRupter 
fault interrupter 

Files with the extension “.WFC” are tagged as S&C IntelliRupter fault 
interrupter Waveform Files. 

Nicolet Power Pro 
WFT  

Files with the extension “.WFT” are tagged as Nicolet Power Pro WFT Files. 

Nicolet PNRF Files with the extension “.PNRF” are tagged as Nicolet PNRF Files. 
S&C PXI Files with the extension “.TSV” are tagged as S&C PXI Waveform Files. 
S&C Extended 
Waveform Capture 

Files with the extension “.EWC” are tagged as S&C IntelliRupter fault 
interrupter Extended Waveform Files. 

Audio Wave Files with the extension “.WAV” are tagged as Microsoft’s Wave Files. 
S&C Meter Files with the extension “.PRO” are tagged as S&C IntelliRupter fault 

interrupter Meter Files. 
DXF Files with the extension “.DXF” are tagged as Drawing Exchange Format files. 
Application Files  Word Documents (“.Doc” & “.RTF”) , Execl Documents (“.XL”, ”.XLS”, “.XLT”, 

“.XLM”, “.XLA”, “.XLC” & “.XLW”) , Web pages (“.HTM”, “.HTML”, “MSPX” & 
“ASP”) , Access Files ('”MDB” & “.ADP”) , Power Point Presenation files 
(“.PPT” & “.PPS”) , Image files (“.GIF”, “.TIF”, “.JPG”, “.JPE”, “.BMP”, “.PSD” & 
“.PDD”) , Zip files (“.ZIP”) , and PDF files (“.PDF”)  are automatically 
associated with their source application. 

ASCII All other files are tagged as ASCII files. 
 
To change the driver type, place the cursor on the filename and select the driver from the Drivers tab. 
Once a driver is assigned the file contents appear in the corresponding display window. If the driver 
encounters an error while reading a file an Invalid Driver Message is displayed indicating the line number 
in which the error was encountered. Use the ASCII or Hexadecimal editors to locate and correct the error. 
The ASCII and hexadecimal editors display the cursor’s line and character number in the lower left corner 
of the window.  

DEVICE CONFIGURATION 
The device configuration dialog allows for setting certain parameters for each type of device driver 
supported. To open, select the Driver Config icon option under the Options tab. The right panel displays all 
the supported device drivers. The Proprietary drivers listed in the right panel are available in the 
Wavewin Universal Viewer and Full versions only Use the mouse or up and down arrow keys to select 
the device. The left panel displays the available settings for each device.  Below is a list of the available 
settings: 
 

• Device’s Data Type: Options (Peak, RMS Calibrated or Log File). Select the type of data that is 
contained in the files for the selected device. 
 

• Device Header Directory: If the device requires support files to display the data then the support 
files can be placed in a centralized directory so they do not have to be in the directories where the 
data files are located. Enter the directory or use the folder button  to browse for an existing 
directory. This field is for devices that maintain separate files for the Analog & Digital information. 
This field is available for Hathaway, Transcan, Rochester and Comtrade Files.Line group files 
used to define lines in DFR files can also be placed in a centrialized path, so they are accesiable 
to all users. 
 

• Change Sampling Frequency:  This field is used to automatically change the sampling frequency 
when a file is displayed for the driver. For example, if the files have 4 samples per cycle and it is 
preferred to view the file with 40 samples per cycles enter 2400. To maintain the original frequency 
leave this field blank or set to 0.00. 
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• Change Line Frequency: If the line frequency is not defined in a specific driver’s files then the 
line frequency can be defined in this dialog. The entered line frequency will be used when 
displaying files for the selected driver. To maintain the original line frequency, leave this field blank 
or enter 0.00.  

 

 
Figure 2.15  Device Configuration Dialog 

DAU-DEF EDITOR 
The DAU-DEF editor allows for changing the setting for all the available devices defined in the selected 
Hathaway DAU-DEF file and for adding new dau def configurations. To open, select the Edit DAU-DEF 
icon option under the Options tab. Navigate to the desired directory and double click on the dau-def file. 
The right panel displays all the devices defined in the file. Use the mouse or up and down arrow keys to 
select the device. The left panel displays the available settings for each device. Below is a list of the 
available settings: 
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• Station Name: Enter or change the station name. 
• Telephone #: Enter the telephone number to connect to the device. 
• Analog Channels: The analog channels defined for the selected DAU-DEF record are displayed 

in a list box.  Use the up and down arrow keys or the mouse to select the analog channel to 
modified.  The following fields can be modifed for each analog channel. 

o Name: Modifiy the analog channel name.   
o Full Scale: Modify the analog channel’s full scale value.  
o Prefix: Modify the analog channel’s prefix.  
o Unit: Modify the analog channel’s unit.  

• Event Channels:  The event channels defined for the selected DAU-DEF record are displayed in 
a list box.  Use the up and down arrow keys or the mouse to select the event channel to modified.  
The following fields can be modifed for each event channel. 

o Event #: Modifiy the event channel’s number.   
o Name: Modify the event channel’s name.  
o NoNc: Modify the event channel’s normally open or normally closed value, option (1,0).  

• Sensor Channels: The sensor channels defined for the selected DAU-DEF record are displayed 
in a list box.  Use the up and down arrow keys or the mouse to select the sensor channel to 
modified.  The following fields can be modifed for each sensor channel. 

o Sensor #: Modifiy the sensor channel’s number.  
o Name: Modify the sensor channel’s name.  
o NoNc: Modify the sensor channel’s normally open or normally closed value, option (1,0). 

 
To add a new DAU-DEF configuration click on anyone of the NOT USED records and fill in the analog and 
digital information and click Save. The DAU-KEY and DAU-TYPE files are updated automatically. 
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Figure 2.16  Hathaway DAU-DEF Editor 

ERLPHASE FILES 
ERLPhase Tesla and Relay Files are displayed in the IEEE Comtrade Binary format. ERLPhase has 
developed an automatic conversion DLL called RecordExAuto.dll and TeslaConfigFileRG.dll to convert 
their proprietary files to the Comtrade format for display. To view ERLPhase Files double click or press 
enter on the orginal Tesla files.  
 
To edit the Tesla AutoComtade configuration, open the Driver Config dialog under the Options tab. Select 
the NxtPhase-Tesla device under the device list box. Below is a list of the available settings: 
 

• Use Long Name Convention: The converted tesla files can automatically be named using the 
IEEE PSRC Long File Naming Convention. Select “Yes” to have them automatically renamed. If 
“No” is selected then the files are named using the original file name with the sampling frequency 
truncated to the name. Example: the “2002-07-23-15.49.01.000F1.tlr” Tesla file’s Comtrade files 
will be named: 2002-07-23-15.49.01.000F1-Converted_S96.dat. 
 

• Delete Original’s: To delete or send the original Tesla file to the recycle bin select “Yes”. All files 
that can be recycled will be sent to the Window’s recycle bin all other are permentally deleted from 
the active drive. To maintain the original files select “No”. 
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• Convert Files: Select the files to Convert to Comtrade when the ERLPhase files are open. The 
options under the drop down box are Waveform Only or All Files. 

 

 
Figure 2.17  Tesla Configuration 

VIEWING/MODIFYING ASCII FILES 
The ASCII Editor allows for viewing and/or modifying the contents of a text file. To open an ASCII file 

place the cursor on the filename and press F2 or click the Edit menu button . Use the up, down, right, 
left, ctrl+right, ctrl+left, page up, page down, home, end, ctrl+home, and ctrl+end keys, the scroll bars or 

the search (F4) and search again (F3)  features to navigate through the file contents. The line and 
character number at the cursor position are displayed in the status bar (bottom left corner of the window). 

The Cut (ctrl+x) , Copy (ctrl+c) , and Paste (ctrl+v)  commands are also provided. New files can 
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be created, or existing files can be opened, saved, and saved under a new name. A maximum of ten 
editing windows can be opened at one time.  
 

 
Figure 2.18  ASCII Editor  

VIEWING/MODIFYING BINARY FILES 
The Hexadecimal Editor allows for viewing and/or modifying the contents of a binary file. To open a binary 
file, place the cursor on the file and press F3 or select the Hex Editor icon under the Driver or Options tab. 
The Hexadecimal window consists of a hex editor and an ASCII display. When a hex value is entered, the 
ASCII equivalent appears in the window to the right of the editor. To navigate through the file contents, 
use the up, down, right, left, page up, page down, ctrl+home, and ctrl+end keys or the scroll bar. The byte 
number at the cursor position is displayed in the lower left corner of the window. To search the contents of 
a hex file, use the search (F4) and search again (F3) functions. To search the ASCII window, enter the 
ASCII information into the “Find Text” Field. To search for a hex value, enter “#”, then the hex number into 
the Find Text field. 
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Figure 2.19  Hexadecimal Editor 

 

 
Figure 2.20  Hexadecimal Search 

VIEWING WAVEFORM SUMMARIES 
The File Manager and Analysis Display generates an analog and digital summary for the supported 
oscillography formats. The summary engine extracts key information from the file and saves it to a small 
summary file. The header, analog, and digital information includes: 
 
Event Information 

Field  Description 
Station Name of the Station associated with the event file. 
Filename Name of the event file. 
File Size File size (displayed in kilobytes). 
Prefault-Time Date and time of the first prefault sample. 
Fault-Time Date and time of the first fault sample. 
Save-Time Date and time the file was saved to disk. 
Process-Time Date and time the file summary was processed. 
Start Date and Time Date and time of the first sample in the file. 
End Date and Time Date and time of the last sample in the file. 
File Duration Duration of the file measured in days, hours, seconds, milliseconds and/or 

microseconds, depending on the type of file. 
Sampling Frequency Sampling frequency and the time between each sample. 
Line Frequency Line Frequency defined in the file. 



Chapter 2 – File Manager Quick Start 

25 

 
Fault Information - Fault Information is displayed for files that include fault information in their format.  

Driver Fault Information 
SEL Event, Location, Frequency, Duration, Shot, Fault Currents, Targets and more. 
DLP Trip Date and Time, Trip Type, Fault Type, Distance and Operating Time. 
Transcan Triggered event information: Name, Time and Type. 
 

Maximum/Minimum Analog Summary   
Field  Description 
Max-Inst Instantaneous maximum values. 
Min-Inst Instantaneous minimum values. 
Max-RMS RMS maximum values. 
Min-RMS RMS minimum values. 
OneBit Channel's full-scale value divide by the channel's resolution. 
Inst-Diff The difference between the Max-Inst and Min-Inst values. 
RMS-Diff The difference between the Max-RMS and Min-RMs values. 
pU Channel prefix and unit. 
Description Channel title and number. 
 

Events/Sensors Activity Summary 
Field  Description 
Fst State at which the channel started, A=alarm and N=normal. 
Lst State at which the channel ended, A=alarm and N=normal. 
Fst-Change Date and time the channel first changed state. 
Lst-Change Date and time the channel last changed state. 
Changes Number of times the channel changed state. 
Description Channel title and number. 
 

Events/Sensors Activity Log 
Field  Description 
State State of the channel at the triggered time, A=alarm and N=normal. 
Trigger Time Time the channel-changed state. 
Description Channel title and number. 

 
The xx:xx:xx.xxx displayed in the Fst-Change and/or Lst-Change fields of the Events/Sensors Activity 
Summary indicates that the digital channel’s state did not change from the initial state (Fst).  
To generate a summary file, place the cursor on the filename and click the Summary  menu button or 
select 2 options available under the Summaries icon under the Options tab. 
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Figure 2.21  Waveform Summary 

WAVEFORM FILE(S) OPTIONS 

OPEN SELECTED FILE 
The Open Selected File option opens the waveform file at the cursor position. Refer to the Displaying 
Oscillography Records section for a list of the supported waveform files. 

OPEN ALL MARKED FILES 
The Open All Marked Files option opens all the marked waveform files, tiles the waveform files 
horizontally and minimizes the file manage. To access the file manager, click the File icon . 
 
A maximum of ten data windows can be opened at one time. 
 

The plot icon  will plot all the marked files. If there are no marked files, the selected file is plotted. 

APPEND WAVEFORM FILES 
The Append Waveform Files option appends the marked files according to time. There are two options 
available under the Append drop down list located under the Options tab: 

• Discard Common Times: Any common times found in the marked files will be deleted from the 
older file.  

• Back-to-Back: The files are appended back-to-back. No samples are deleted. 
 

When the system appends files, it first finds the file with the oldest date and time. It then checks that all 
other marked files analog and digital channel titles and the scale factors for each analog channel 
match. If any of these do not match them the file is not included in the final appended display. When a 
file does not match a message box is displayed indicating the file will not be included in the waveform 
display.  
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Figure 2.22  Append Waveform Files: Discard Common Times 

 

 
Figure 2.23  Append Waveform Files: Back to Back 

MERGE WAVEFORM FILES 
The Merge Waveform Files option merges the marked waveform files. There are two options available 
under the Merge drop down list located under the Options tab: 
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• By Time: Merge channel samples if they have a common time segment. The reference time is 
derived from the file with the latest start date and time. The file with the least number of 
samples determines the length of the newly merged file.  

• By Sample: Merge regardless of time stamps. The reference time is derived from the first 
marked file. The file with the least number of samples determines the length of the file. 

 
When files with different sampling frequencies are merged a dialog will be displayed. The dialog 
contains a list of all the sampling frequencies in the marked files. Select the frequency for the merged 
file or enter a new frequency. 
 

 
Figure 2.24  Merge Waveform Files: Select Frequency 

 
If the merged files have different data types (RMS Calibrated or Peak Values) then the RMS values will 
be converted to Peak values by multiplying the RMS values by Root 2. 
 
To identify the merged channels the station name for each file is added to the beginning of the analog 

and digital channel names. To turn this feature off open the Properties dialog  in the analysis 
window. Click on the Append/Merge tab and uncheck the Add the File’s Station Name to Beginning of 
the Analog/Digital Channels field. 
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Figure 2.25  Append/Merge Properties 

 

 
Figure 2.26  Merge Waveform Files By Time 
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Figure 2.27  Merge Waveform Files By Sample 

FILE REPORTS  

GENERATING CALIBRATION REPORTS 
The Calibration report list the Maximum and Minimum analog summary information for the marked files. 
Calibration reports should only be generated on files that contain no fault data such as snapshot files. 
To generate a report, mark the desired files and select the Calibrate icon under the Options tab. Refer 
to the “Summary” section for field descriptors. The report information is saved in the DVREPORT.DTB 
file located in the Wavewin directory. 

GENERATING SEQUENCE OF EVENTS (SOE) REPORTS 
To generate a table of sequence of events from multiple waveform files, mark all of the desired files 
then press F11 or Select the SOE List icon under the Options/Reports tab. A table listing all of the 
events triggered in the selected files is displayed. The table is sorted according to date and time. The 
columns listed in the table include: 
 

State:  The state on the event/sensor at the displayed date and time (A=Abnormal, N=Normal). 
Trigger Date:  The date the event/sensor triggered or cleared. 
Trigger Time:  The time the event/sensor triggered or cleared. 
Chan:  The channel number of the event/sensors in the file from which it was read. 
Channel Title:  The channel title of the event/sensors. 
Device:  The device from which the event/sensors originated. 
Substation:  The substation from which the event/sensors originated. 
File:  The filename from which the event/sensors originated. 

 
The Query section at the bottom of the table allows for searching events from specific substations, 
devices, and channels. To plot the specific events press <enter> or double click on the event. 
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Figure 2.28  SOE List 

GENERATING SEQUENCE OF EVENTS (SOE) SUMMARIES 
To generate a summary of the sequence of events for multiple waveform files, mark all the desired files 
then Select the SOE Summary icon under the Options/Reports tab. A table listing a summary of all the 
events triggered in the selected files is displayed. The table is sorted according to date and time. The 
columns listed in the table include: 
 

Substation:  The substation that triggered the event/sensor. 
Device:  The device that triggered the event/sensor. 
Fst-State:  State the channel started at, A=alarm and N=normal. 
Lst-State:  State the channel ended at, A=alarm and N=normal. 
Fst-Change Date:  Date the channel first changed state. 
Fst-Change Time:  Time the channel first changed state. 
Lst-Change Date:  Date the channel last changed state. 
Lst-Change Time:  Time the channel last changed state. 
Changes:  Number of times the channel changed state. 
Chan #:  Channel number in the file. 
Channel Title:  The channel title of the event/sensor. 
File:  The filename from which the event/sensors originated. 

 
The Query section at the bottom of the table allows for searching events from specific substations, 
devices, and channels. To plot the specific events press <enter> or double click on the event. 
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Figure 2.29  SOE Summary 

VIEWING ASCII FILES IN DATABASE FORMAT 
The database viewer provides an effective way to organize, sort, and search comma delimited, double 
quoted comma delimited, or tab delimited text files. The data is presented in tabular form, and an unlimited 
number of rows and columns can be displayed. The viewer allows for intelligent queries, column sorting, 
selecting, and grouping data, row deletion, printing, saving, and saving in a new file. 
 
Use the column headers to sort the data in ascending or descending order and the query fields to search 
the data. Refer to the Querying Files section for more information. To browse the data, use the up, down, 
right, left, page-up, page-down, home, end, ctrl+home, and ctrl+end keys or use the scroll bars. Rows 
must be marked to delete them from the table. 
 

 
Figure 2.30  Database Viewer 
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SHOW/HIDE CHANNEL TITLES 
The data plotting window automatically hides channels that contain certain characters in the channel title. 
Below is a list of the characters defined as invalid channels when a file is displayed.  
 

• UNUSE 
• UNDEF 
• NOT D 
• NOT U 
• NOT I 
• NOT A 
• { 
• N/A 
• ANALOG INPUT 
• UNTITLED 
• ANALOG CHANNEL 
• EXTERNAL INPUT 
• EVENT CHANNEL 
• CHANNEL: 
• DIGITAL TRACE # 
• SPARE 

 
If a channel title contains the above characters in the beginning of an analog or digital channel title the 
channel is automatically hidden. These characters can be modified to show a channel when a file is 
displayed. To show a title that contains the above characters select the Show/Hide Titles icon under the 
Options tab. 
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Figure 2.31 Show/Hide Channel Titles Dialog 

 
To show a title, uncheck the checkbox next to the displayed invalid channel title. To remove a title from the 
list, select the title in the list box then click the Remove button or press the delete key. To add a new title, 
first type the new title in the edit box then click the Add button. The new title is added to the end of the list 
with the checkbox automatically checked.  

QUERYING FILES 
The query fields are used to search for specific information in the table. Query fields are located below the 
table. Use the tab key to move the cursor from the table to the query fields and up arrow to return to the 
table. The Ctrl-left/right keys move the edit box between the query fields. Each field contains an input and 
an operator. The inputs are directly entered from the keyboard and may include the “*” and “?” wild cards. 
Operators are located above the input fields and can be changed by clicking the mouse button on the 
operator symbol or by pressing the F9 key. The selectable options include equal to (=), less than (<), and 
greater than (<).  
 

 
Figure 2.32  Query Fields 
 
When a query is launched, the engine numerically compares the input with the information in the table. If 
numerical comparison is not possible, symbolic comparison is performed. When multiple fields are 
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defined, the engine searches for a match on the first field “AND” on the second field “AND” on the third 
field and so on. 
 
Three query options are available: Query All Files, Query Marked Files, or Query Unmarked Files. Files 
that meet the specified query requirements are marked, grouped, and displayed at the top of the table. 
Use the Ctrl-left/right keys to navigate through the query fields and the <enter> key to process the query. 

DSITURBANCE REPORT 
The disturbance report feature creates a comma delimited file that contains the following information for 
each file processed (if available in the file): 
 

• Utility Name,  
• Device Name (Fault),  
• File Start Date & Time,  
• Substation Name,  
• Report Date, 
• Faulted Phase,  
• Fault Location,  
• Line Length,  
• Fault Current,  
• Maximum Voltage,  
• Maximum Frequency, 
• Minimum Frequency,  
• Pass/Fail,  
• Passed Filters and the  
• Source file's folder and filename. 

 
The disturbance report dialog allows for setting the report's destination folder and filename. It also allows 
for setting the folder(s) where the event files are located. The filter section is for setting filter levels for the 
Faulted Phase, Fault Location, Current and Voltage thresholds, and the deviation for the frequency. 
 
To open the disturbance report dialog, select the Disturbance icon under the Options tab. The 
disturbance report is only available in the Wavewin Universal Viewer and Wavewin Full Version. 
 

 
Figure 2.33  Disturbance Report Dialog 
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The disturbance dialog has 3 sections: Destination Folder & File, Source Folder(s), and Filters. Each 
section is explained in the following sections along with the functions for each button. 
 
DESTINATION FOLDER & FILE: 
The Destination Folder & File section is used to set the disturbance report folder & filename. Type the 
drive, folder and filename into the Destination File field or use the Browse button to locate an existing file 
or for creating a new file and/or folder. 
 

 
Figure 2.34  Disturbance Report: Destination Folder & File 

 
To save the disturbance information to a new file, click the Create New File radio button. This option will 
clear the file before processing the event files. To append the disturbance information to the end of an 
existing file, click the Append Existing File radio button. 
 
FOLDERS: 
The Folders section is used for defining where the event files are located. To process files located in the 
File Manager's active folder check the Process Files in the Active Folder check box. If files are marked in 
the active folder, then this feature will process only the marked event files. If there are no marked files, 
then all the event files are processed. 
 
If the event files are in different folders, then use the Add button to add a folder to the Source Folder list. 
To remove a folder from the list, use the Delete button. 
 

 
Figure 2.35  Disturbance Report: Source Folder(s) 

 
FILTERS: 
The Filters section is used to define the faulted phases, the filter levels for the fault location, voltage class 
and fault current levels. It also defines the deviation of the maximum and minimum frequency values from 
the Line Frequency. 
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Figure 2.36  Disturbance Report: Filters 

 
After the filters are applied to the data file the file will be tagged with PASS or FAIL. A PASS means that 
the file’s fault type exists in the list AND the fault location is within the entered percentage of the line 
length AND the fault current is above the entered fault current value AND the voltage class is above the 
entered voltage class value OR the maximum or minimum frequency is above the entered deviation from 
the line frequency. The calculations used are listed below: 
 
For files with no Voltage Channels a PASS Equals: 

Faulted Phase is in the List of Filter Phase Settings 
AND 
Maximum Fault Current is > Entered Fault Current Filter 
OR 
|Maximum/Minimum Frequency Value - Line Frequency| is > Entered Filter Deviation Value 

 
For files with Voltage Channels a PASS Equals: 

Faulted Phase is in the List of Filter Phase Settings 
AND 
Fault Location is < Entered % of the Line Length 
AND 
Maximum Voltage Value is > Entered Voltage Class Filter 
AND 
Maximum Fault Current is > Entered Fault Current Filter 
OR 
|Maximum/Minimum Frequency Value - Line Frequency| is > Enter Filter Deviation Value 

 
Each file in the report also lists the filters that triggered. The 5 columns to the right of the PASS/FAIL 
column list the filters that triggered. Each column is labeled according to the filter: 

P = Faulted Phase Filter 
L = Fault Location Filter 
C = Current Filter 
V = Voltage Filter 
F = Frequency Filter 

 
 If a filter triggers, then the filter letter is displayed in the columns otherwise it is left blank. 
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Figure 2.37  Disturbance Report 
 
The Process button starts the disturbance report. Once started the Disturbance dialog is closed and each 
file is processed. The progress bar displayed in the button speed bar is updated according to the number 
of files to process and the current file being processed. 
 
When the processing is complete a comma delimited table is displayed. The comma delimited table allows 
for sorting each column by clicking on the column’s header. The query section located below the table 
allows for quick searches for specific files. Also, the processed files can be displayed by double clicking on 
a row or moving the table cursor to the row and pressing enter. The file will be displayed in the analysis 
window. 
 

 
Figure 2.38  Disturbance Display File 
 
BUTTONS: 
There are 5 buttons displayed at the bottom of the disturbance dialog. Each button is explained in the 
following table: 
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1. Process Button: The process button starts the disturbance report. The dialog is closed, and each file 
is processed. The progress bar displayed in the button speed bar is updated according to the number 
of files to process and what file is currently being processed.  
 

2. Save Script: All the information displayed in the dialog is saved in a script file located in the folder 
where Wavewin is located. The file is called: Disturbance.ini. A message box is displayed confirming 
that the information has been saved. The dialog information is also saved to the Disturbance.ini file 
when the “Process” button is clicked. 
 

3. Edit Script: The edit script button closes the dialog and displays the Disturbance.ini file in the ASCII 
editor.  
 

4.  Show Help: The show help button displays the help information in a note pad below the buttons. The 
window size is increased to show the note pad. When the help window is displayed the Show Help 
button’s text changes to Hide Help. To hide the help window, click on Hide Help. 
 

5. Close: Close the dialog without saving the entered information. 

COMPLEX CALCULATOR 
The complex calculator is used to perform complex mathematical operations. Operations can be 
performed in Polar or Rectangular form. Also, there are 4 memory locations used to store the results of an 
operation. To store a result first click on the memory location radio button then click on the down arrow 
next to the Magnitude edit box. To recall a memory location, click on the memory locations radio button 
then click on the Recall button. The Clear All button clears all four memory locations.  
 
The calculator operates as an HP calculator. After each entry click the “Enter” button to record the values 
in the Accumulator. 
 
The calculator icon is in the Files tab in the File Manager and in the Data tab in the Analysis window. 
 

 
Figure 2.39  Complex Calculator 
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AUTO CONVERT TO COMTRADE 
The auto convert to Comtrade dialog is used for defining the properties to automatically convert specific 
file types to the IEEE C37.111 Comtrade format. To specify the Comtrade format the files will be saved in, 
select from the Save As Type drop down list. To save the SEL settings from the original files check the 
Save SEL Settings checkbox. The SEL setting is saved to the Comtrade’s Header .HDR file/section. 
 
Auto Convert to Comtrade monitors the entered “Source Path” for the defined file extensions. When a file 
is detected, it first saves the output Comtrade file to the defined “Destination Path” then archives the 
source file to the defined “Archive Path”.   
 
The SEL Sag/Swell/Interruption (SSI) files contain multiple event information stored with big gaps of time 
between each event. These files will be scanned for events and each event will be saved in a separate 
Comtrade file. To define the boundaries for the SSI files, enter then minimum number of cycles required 
before saving to Comtrade, the default is 2 cycles. Also, enter the maximum number of milliseconds 
between samples before the SSI data is separated into multiple Comtrade files, the default is 50 
milliseconds. 
 
To open the Auto Convert to Comtrade dialog select the Auto Convert icon under the Options tab in the 
File Manager. Enter the source path, destination path, archive path, file extensions separated by commas 
and the scan period in minutes. Auto convert to Comtrade monitors the Source path for the defined file 
extensions every scan period. 
 
To start the process, click on the Start Convert button. Once the conversion starts the button caption will 
change to End Convert. To end the conversion process, click on the End Convert button. If a file already 
exists in the destination path, then the file is overwritten. The status of each scan is displayed in the Status 
section of the dialog. 
 
To have the auto convert to Comtrade process started when Wavewin is ran check the Automatically Start 
Convert to Comtrade at Run Time check box. The conversion process is performed in the background. 
The dialog is not required to be open for the process to execute. To check the status of the conversion, 
open the dialog. The Next Scan In field reports how many minutes before the next scan is started. 

 
Inputs: 
 

Field Definition 
Properties:  
Source Path Path where the original files are located. 
Include Sub-Folders Scan all sub-folders under the Source path. 
Destination Path Path where the converted Comtrade files are saved. 
Automatically Rename Automatically rename all converted Comtrade files to the IEEE 

long file naming format. 
Archive Path Path where the original files are archived after they are converted 

to Comtrade. 
File Extensions The extension of the files to convert to Comtrade separated by 

commas, *.SSI,*.EVE 
Scan Period The scan period in minutes. 
Save As Type Select the type of Comtrade format to save the original file in. 
Save the SEL Settings Save the SEL setting information in the original file to the 

Comtrade’s header file/section.  
SEL SSI Files  
Minimum # of Cycles The minimum number of cycles required before saving to 

Comtrade. 
Milliseconds Difference The maximum number of milliseconds between samples before 

the SSI data is separated into multiple Comtrade files. 
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Figure 2.40  Auto Convert To Comtrade 

SHORTCUTS 
For easy access to the tab options in the file manager and data plotting window a shortcut drop-down 
menu button can be configured from the Shortcuts dialog. To open the Shortcuts dialog, open the Display 
dialog from the File Manager’s Options tab. Click the Shortcuts button. 
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Figure 2.41  ShortCut Dialog 

 
There are two tabs, one for the file manager and one for the data plotting window. Click on the tab to 
define the shortcuts. Select the tab items using the Ctrl-default mouse button then click the green Move 
button. All selected tab items will be copied to the User Shortcuts list. To delete tab items from the User 
Shortcuts list, select the item and click the “Delete” button.  
 
To arrange the shortcuts, select the item and click the Move Up or Move Down buttons. Click OK to save 
the shortcuts or Cancel to abort the changes. 
 
When the shortcuts are saved a new drop-down menu button is added to the appropriate menu bar. 
 

 
Figure 2.42  ShortCut Menu 
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SEARCH FILE CONTENTS 
The Search File Contents dialog allows for searching ASCII files for key words and displaying the results 
in a table format. To open the dialog, select the Search icon under the Files tab/menu.  
 
This dialog allows for selecting the Start Date, End Date, Search Path, the file extensions to search, the 
key strings to search for and the path where the results will be saved. Refer to the following table for more 
details on each field: 

 
Field Definition 
Start Date: Select the Month Day and Year from the Start Date drop down list 

boxes. This defines what files to search in the the defined Search Path 
and Included Sub Folder if specified. If the files save date is equal to or 
greater than the selected start date and less then or equal to the 
selected end date then that file is searched for the entered search 
strings. 

End Date: Select the Month Day and Year from the End Date drop down list 
boxes. 

Search Path: Enter the Search Path or use the Browse button to the select the path. 
Include Sub Folders: To include all sub folders under the Search Path click the Include Sub 

Folder check box. 
Extensions: Enter the file extensions to search separated by commas, for example: 

*.DTB,*.TXT,*.CSV. 
Search Strings: Enter the search string to look for. For multiple search strings separate 

each string by a comma, for example: password, logon. 
Report Path:: Enter the Report Path or use the Browse button to the select the path. 

 
The Start Date and End Date define what files to search. If a file’s save date is within the start and end 
dates, then that file is included in the search. 
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Figure 2.43  Search File Contents Dialog 
 

The dialog also allows for saving the search fields to an ASCII txt file and for opening existing search files. 
Use the Save, Save As and Open buttons to save the active search to the active file listed in the status 
field, save the search fields under a new file name or for opening an existing search file. The search fields 
are saved to the ASCII text file in an INI file format: 
 
[START DATE] 
01\01\2016 
[END DATE] 
01\01\2020 
[SEARCH PATH] 
C:\FaultLib\SDCMess 
[INCLUDE SUBFOLDERS] 
1 
[SEARCH FILES] 
*.DTB 
[SEARCH STRING] 
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password 
[REPORT PATH] 
C:\FaultLib\SDCMess\Backup  
 
To start the search, click the Search button. If results are found then the results are saved to a CSV file 
with the following file name: yymmdd,hhmmss,Search Results.CSV.  
 
The Search Results status window section displays the search path, each file being searched, and the 
number of search items found. 
 
To view the search results, click the View Results button. A table is displayed with the following columns: 

 
Field Definition 
Occurance The occurance number in the listed filename. 
File Date The save date of the file. 
File Time The save time of the file. 
Search String The search string found. 
Line Number The line number where the search string was found in the file. 
Line Text: The text of the line number number. 
FileName: The path and filename where the search string exists. 

 

 
Figure 2.44  Search File Results 

 
To view the file and line number of the search results double click on the table row of the desired search 
item. The file will be displayed in an ASCII editor at the specified line number. 

AUTO PROCESS TEMPLATES 
The Auto Process Templates dialog allows for automatically extracting key information from waveform 
files and saving the extracted information to a comma separated ASCII file with a .DIG extension. The 
.DIG file can then be imported into a database.  
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The Auto Process Templates feature is only available in the Wavewin Universal Viewer and 
Wavewin Full Version. 
 
The template files contain script commands that will perform calculations on the voltage and current 
channels. For the calculations to work properly the analog channels must be in the right position. For this, 
line groups are created. The line groups ensure that the voltage channels (VA, VB, VC) are the first 3 
channels displayed and the next 4 are the current channels (IA, IB, IC, IN).  
 
A line group file is created for each specific device. The name of the line group file is composed from the 
first line in the Comtrade .CFG file. The line group file has a .LNG extension. In the Comtrade standard 
(C37.111) the definition of the first line in the CFG file is defined below: 
 
Station name, identification of the recording device, and COMTRADE Standard revision year 
 
The line group file name can be named using the first field in the CFG file or a combination of the first and 
second fields separated by a comma. For example, if a device saves the .CFG files with “MyStation” as 
the first field and “MyDevice” in the second field on the first line then the line group file will be 
MyStation.LNG or MyStation,MyDevice.LNG. The system first looks for the line group file with the first field 
name, if that is not found it looks for a combination of the first and second.  
 
To create a line group file for each Comtrade file being processed use the versioning option inside the File 
Manager’s display dialog. When Comtrade files are extracted from the device a new file is created with the 
same name as the .CFG and .DAT but with the extension LGP. The LGP is a copy of the LNG file but 
named to be associated with the Comtrade file. This allows for a versioning system. It preserves the line 
group information for past Comtrade files. To activate the versioning system, open the Display dialog 
under the Options tab in the File Manager. Select the Data Plotting tab. Under the Process File group 
select Yes from the Versioning field’s drop-down list.  
 
The Auto Process Template will monitor a path, and all sub-directories, is specified, for new files to 
process. There are two ways new files can be processed, By Save Date or by adding a WWD to the end 
of the file name. To define the processing type, open the Display dialog under the Options tab in the File 
Manager. Select the Data Plotting tab. Under the Process File group select Rename with WWD or By 
Save Date from the Process Type field’s drop-down list. The field to the right of the Process Type field will 
change according to the selected type. If By Save Date is selected the field to the right will be Start DT. 
This field displays the last file’s date and time that was processed. If no files have been processed yet, it’s 
default date and time is 01/01/1970 00:00:00. To start at a specific date and time enter the desired date 
and time.  
 
If renamed with WWD is selected the field to the right will be Batch Files. This field allows for selecting 
what files will be processed in the directories, All the files or just the new files. New files are any file that 
does not have a ,WWD in the last field of the filename. 
 
The Process File section in the Display dialog allows for defining several fields for customizing the auto 
process template feature. Each field is defined below. 

 
Field Definition 
Process Type Select how the files are processed, By Save Date or by renaming a 

processed file by adding a ,WWD at the end of the filename. If Rename is 
selected the next field will be Batch Files. If Save Date is selected the next 
field is Start DT 

Batch Files Select the type of files to process, All files or New Files. New files will only 
process files that do not have a WWD added to the end of the name. 

 Start DT Defines the start date and time for processing new files. 
Versioning Create a line group version file for each waveform file processed. The line 

group is named the same name as the processed file with a .LGP extension. 
Process # Select the number of files to Process during each run. The default is 256.  
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Field Definition 
PDF Files Create a PDF file for the processed line group. There are 4 options to 

selected from: 
All Files: Create a PDF file for each line group processed. 
No Files: Do not create PDF files. 
Breaker Opt & Fault Type: Only create PDF files for lines that had a 
breaker operate and a fault type exists. 
Fault Type: Only create PDF files for lines that have a fault type. 

Convert DT to Local Convert all Date and Times in the final DIG file from UTC to local time. 
PDF Width Defines the width of the PDF document.  
PDF Height Defines the height of the PDF document. 
Delete After Delete the after it has been processed. 
Delete No Line Group Delete files that have no line groups defined. 
Rename After Rename the processed DIG file to a long filename before processing the 

next batch of files. 
Time Code The time code used when renmaing the DIG file. 
Station The station name used when renmaing the DIG file. 
Device The device name used when renmaing the DIG file. 
Set Data Bar When processsing files the data bar is postioned in the fault area. The data 

bar can be positioned a number of cycles from the files trigger position or 
from the systems calculated trigger time.  

# Cycles from Bar Position the data bar froma number of cycles from the selected trigger 
position. The options are 1, 1.2, 1,75 or 2 cycles. 

Move Files The Move Files with no Line Groups to the sub-folder No-LineGroups field 
will move any files that do not have line groups associated with them to a 
sub-folder named No-LineGroups if Yes is selected from the drop-down 
options. All associated files to the data file will also be moved. 

 
The next two sections (Line Group and Templates) explain how to create line groups and template files. 
These are the two main items needed to successfully process waveform files.  
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Figure 2.45  Auto Process Templates Properties 
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Figure 2.46  Auto Process Templates Dialog 

LINE GROUPS 
 

A Line Group defines all the information needed to view and analyze (manually or automatically) the 
data for a specific feeder from an installed DME or Relays. The information includes analog channels, 
associated breakers and other digital events, remote end, and line impedance information. 
 
The line group file contains the following information: 
 
[S-D456] 
LineName=S-D456 
RemoteDME=Bainbrook 345kv 
RemoteName=S-E567 
RemoteDevice=DFR Unit 1 South Station 
VaChan=22 
VbChan=23 
VcChan=24 
IaChan=25 
IbChan=26 
IcChan=27 
InChan=28 
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Breaker1=1 
Breaker2=2 
Event1=14 
Event2=15 
Event3=16 
Event4=17 
Event5=18 
Event6=19 
Event7=20 
Event8=21 
Event9=22 
Event10=83 
Event11=84 
Event12=85 
Event13=86 
Event14=87 
Event15=88 
Event16=89 
Event17=90 
Event18=91 
VaColor=Red 
VbColor=Blue 
VcColor=Green 
IaColor=Red 
IbColor=Blue 
IcColor=Green 
InColor=Fuchsia 
PosSeqR=0.46301 
PosSeqX=2.50905 
ZeroSeqR=5.09427 
ZeroSeqX=5.66559 
LineMiles=9.9 
FromBus=1400 
ToBus=1000 
Cktnum=50 
PhaseRotation=ABC 
 
TimeAdjustment=-4 
 
For relay files a line group file will contain one line group, but for DFR files a maximum of 25-line 
groups can exist in one file. Below are definitions for each line in a line group: 

 
Field Description Format 

LINE NAME Feeder Name Text (up to 12 Characters) 

REMOTE DME Remote DME Station Name Text (up to 24 Characters) 

REMOTE NAME Remote Line Designation Text (up to 12 Characters) 

REMOTE DEVICE Remote Device Name Text (up to 24 Characters) 

VA CHAN VA Analog Channel Number Integer Number (1 to 255) 

VB CHAN VB Analog Channel Number Integer Number (1 to 255) 

VC CHAN VC Analog Channel Number Integer Number (1 to 255) 

IA CHAN IA Analog Channel Number Integer Number (1 to 255) 
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IB CHAN IB Analog Channel Number Integer Number (1 to 255) 

IC CHAN IC Analog Channel Number Integer Number (1 to 255) 

IN CHAN Neutral Analog Channel Number Integer Number (1 to 255) 

BREAKER 1 Digital Channel – Breaker 1 Status Integer Number (1 to 1024) 

BREAKER 2 Digital Channel – Breaker 2 Status Integer Number (1 to 1024) 

EVENT 1 Digital Channel – Event 1 Status Integer Number (1 to 1024) 

EVENT 2 Digital Channel – Event 2 Status Integer Number (1 to 1024) 

EVENT N Digital Channel – Event N Status Integer Number (1 to 1024) 

VA COLOR VA Channel Color Text (Example: Red) 

VB COLOR VB Channel Color Text (Example: Blue) 

VC COLOR VC Channel Color Text (Example: Green) 

IA COLOR IA Channel Color Text (Example: Red) 

IB COLOR IB Channel Color Text (Example: Blue) 

IC COLOR IC Channel Color Text (Example: Green) 

IN COLOR Neutral Channel Color Text (Example: Fuchsia) 

POS SEQ R Real Positive Seq Line Impedance Real Num (5 Decimal Digits) 

POS SEQ X Imaginary Positive Seq Line Impedance Real Num (5 Decimal Digits) 

ZERO SEQ R Real Zero Seq Line Impedance Real Num (5 Decimal Digits) 

ZERO SEQ X Imaginary Zero Seq Line Impedance Real Num (5 Decimal Digits) 

LINE MILES Total Line Length in Miles Real Num (2 Decimal Digits) 

FROM BUS CAPE From Bus Designation Integer Number (up to 9999) 

TO BUS CAPE To Bus Designation Integer Number (up to 9999) 

CKT NUM CAPE Circuit Number Integer Number (up to 9999) 
PHASEROTATION The Phase Rotation (ABC - ACB) Text (up to 3 Characters) 

TIMEADJUSTMENT The number of hours to adjust to the 
proper time. 

Integer 

TEMPLATES  
 

Once the line groups are defined then template files can be built to extract key information from the 
files. Below is a list of the script commands that can be used in the template files. 
 
Window Commands 
<Station> Write the full Station name. 
<Station:12> Write the first 12 characters of the Station name. If the Station name is less than 12 

characters then blanks are pads in front of the name. 
<Device> Write the full Device name. 
<Device:6> Write the first 6 characters of the Device name. 
<Date:F> Write the Date at the data bar in the following format mm/dd/yyyy. 
<Time:F> Write the Time at the data bar in the following format hh:mm:ss.zzzzzz. 
<Date:U> Write the Date at the data bar in the following format yyyymmdd. 
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<Time:U> Write the Time at the data bar in the following format hhmmsszzz. 
<Cycles> Write the number of Cycles between the data bar and the reference bar. 
<DeltaX> Write the time difference between the data bar and the reference bar. 
<Line> Write the active Line name. 
<Data> Write if the data being processed is BAD or GOOD. This is determined by the size 

of the binary file compared with the calculated size using the total samples * scan 
size. 

<Remote> Write the Remote Feeder Name as defined in the Line Group, REMOTENAME=. 
<RDME> Write the Remote Station Name as defined in the Line Group, REMOTEDME=. 
<RDEV> Write the Remote Device Name as defined in the Line Group, REMOTEDEVICE=. 
<PHSROT> Write the Phase Rotation as defined in the Line Group, PHASEROTATION=. 
<SFreq> Write the sampling frequency at the data bar or reference bar. 
<LFreq> Write the line frequency. 
<LL> Write the Line Length. 
<Z1M> Write the Z1 Magnitude. 
<Z1P> Write the Z1 Angle. 
<Z0M> Write the Z0 Magnitude. 
<Z0P> Write the Z0 Angle. 
<Filename> Write the Filename displayed in the data plotting window. 
<Triggers> Write the number of triggers for the script commands. 
<Cktnum> Write the Circuit Name as defined in the Line Group as CKTNUM=. 
<Tobus> Write the To Bus Name as defined in the Line Group as TOBUS=. 
<Frombus> Write the From Bus Name as defined in the Line Group as FROMBUS=. 
<ReportFile> Write the name of the generated PDF report file. If there was no report file 

generated it writes NONE. 
 

Analog Commands 
<> Write the analog data at the data bar, 
[] Write the analog data at the reference bar, 
Number Write the visible analog column data at the date bar separated by commas for 

specified Channel number. 
^Number Write all the visible analog column data separated by commas for the Channel in 

number position. 
:A Write the average value for the whole channel. 
:C Write the RMS value for the last cycles in the file. 
:R Write the RMS value. 
:T Write the Channel Title. 
:U Write the Channel Unit. 
:P Write the Phase value. 
:I Write the Instantaneous value. 
:F Write the DFT magnitude for the specified Harmonic. For example, ^6:F0 writes the 

DFT Magnitude of the DC Offset for channel 6 and ^6:F2 writes the DFT Magnitude 
of the 2nd Harmonic for channel 6.  

:D Write the Duration of the Fault. 
:H Write the value DC Offset divided by the fundamental. Indicates a pegged channel. 
:X Write the CT ratio. 
:Y Write the PT ratio. 
:Z Write the frequency. 
:W Write the megawatts. 
:V Write the megavars. 
:% Write the Percentage of Nominal from the Prefault bar to the Fault bar.  
:%v Measures voltage sag immunity. 
:+ Write the channels maximum value. 
:- Write the channels minimum value. 
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:Number Specifies the width of the analog data values. Will only be applied if the defined 
width is greater than the length of the data values. Spaces are padded to the 
beginning of the written values. This is used to right justify values. 

:S The skew of the 3 analog channels using the angles. The S command is used with 
3 analog channels <1,2,3:S>. This command adds the 3 angles at the cursor. One 
of the channels must be marked as a reference channel. 

:B The Unbalanced Value for 3 Channels. The B command is used with 3 analog 
channels <1,2,3:B>. This command finds the highest and lowest DFT magnitude of 
the 3 channels. The result is the highest – lowest. 

:N The Negative Sequence for 3 Channels. The N command is used with 3 analog 
channels <^1,^2,^3:N>. This command computes the negative sequence for the 3 
current or voltage channels in position 1, 2 and 3 on the screen. The magnitude for 
the negative sequence result is displayed. 

:Q The Positive Sequence for 3 Channels. The Q command is used with 3 analog 
channels <^1,^2,^3:Q>. This command computes the positive sequence for the 3 
current or voltage channels in position 1, 2 and 3 on the screen. The magnitude for 
the positive sequence result is displayed. 

:M The M command is used for an entire channel. It calculates the maximum value of 
the channel minus the minimum value of the channel divided by 2 ((max-min)/2), 
<^1:M>. Since the command is not sample based both types of brackets can be 
used (<>,[]).  

:SG100 
:BL50 
:NG5000 
:ML700 

The letter G or L followed by a number after the :S, :B, :M or :N defines a trigger. 
The letter G stands for greater than and L is less than. If the result is true than 
Alarm is displayed else Normal is displayed. 

 
Example Analog Commands 
<1> Write the visible analog column data at the date bar separated by commas for 

Channel 1. 
<^1> Write the visible analog column data separated by commas for the Channel in 

position 1. 
<1:R> Write the RMS value at the data bar for Channel 1. 
<2:T> Write the Channel Title for Channel 2. 
<^3:U> Write the Channel Unit for the Channel in position 3. 
<4:P> Write the Phase value for channel 4. 
<^5:I> Write the Instantaneous value for the Channel in position 5. 
<6:F5> Write the DFT magnitude of the 5th Harmonic for Channel 6. 
[^1] Write the visible analog column data at the reference bar separated by commas 

for Channel 1.  
<^1:MG1000> Write Alarm if the ((max-min) / 2) is greater than 1000 else it writes Normal. 
<^1,^2,^3:S> Write the sum of the angles at the data bar. One of the 3 channels must be 

marked as a reference channel. 
[^1,^2,^3:B] Write the difference between the highest and lowest DFT magnitude at the 

reference bar. 
<^1,^2,^3:N> Write the magnitude of the negative sequence at the data bar for the channels in 

position 1, 2 and 3. 
<^1,^2,^3:NG50> Write Alarm if the magnitude of the negative sequence is greater than 50 or it 

write Normal if the magnitude of the negative sequence is less than or equal to 
50 for the channels in position 1, 2 and 3 at the data bar. 

 
Digital Commands 
B1:T Write the Breaker 1 Digital Channel Trigger Information as defined in the Line 

Group as Breaker1=. The output text is the Digital Channel Title/Start 
Second:Milliseconds/Duration. If the Digital Channel started in Alarm state, then NA 
is defined as the start date. If the Digital Channel started in Alarm state or ended in 
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Alarm state, then NA is written for the Duration.  
B2:T Write the Breaker 2 Digital Channel Trigger Information as defined in the Line 

Group as Breaker2=. The output text is the Digital Channel Title/Start 
Second:Milliseconds/Duration. If the Digital Channel started in Alarm state, then NA 
is defined as the start date. If the Digital Channel started in Alarm state or ended in 
Alarm state, then NA is written for the Duration. 

E1:T Write the Event 1 Digital Channel Trigger Information as defined in the Line Group 
as Event1=. The output text is the Digital Channel Title/Start 
Second:Milliseconds/Duration. If the Digital Channel started in Alarm state, then NA 
is defined as the start date. If the Digital Channel started in Alarm state or ended in 
Alarm state, then NA is written for the Duration. 

B1:S Write A (Alarm) or N (No Alarm) indicating if the Breaker 1 Trigger status in the File. 
E3:D Write the Event 3 Start Time  
B1:E Write the total number of times the digital channel toggled. 

 
When a carat ^ is specified before the channel number it indicates the channel position in the display. 
 
The < > characters saves the analog data at the data bar and the [ ] characters saves the analog data 
at the reference bar. To open the Auto Process Template dialog, select the Process Templates icon 
under the Options tab. 
 
The Auto Process Template dialog allows for 5 templates to be processed at one time. Enter or select 
the template files in the template fields. Enter or select the report path where the report files are saved. 
If the Process Type defined in the File Manager’s display dialog is Rename with WWD then the 
Process Files field will be enabled. Select what files to process, All Files will process all the files in the 
active path and included sub folders. After a file is processed a WWD is added to the last field in the 
long filename. This tags the file as processed. To only process new files, select the New Files option. 
 
If the Process Type defined in the File Manager’s display dialog is By Save Date, then all files that have 
a save date greater than the one defined in the Display dialog are processed. 
 
If files are marked in the active path the Process Only Marked Files check box will be enabled. Click 
this option to process only the marked files. To include all the sub folders under the active path, click 
the Include Sub Folder check box.  

 
To start the process, click the Run button. When the Run button is activated the fields in the dialog will 
be saved and the dialog will be closed. Each specified file will be opened in the analysis window, the 
Mark and Save window will be opened and each line group will be selected in the file. The template 
fields will be processed for each line group and saved to the appropriate report file. The report files are 
saved to the specified report path and each report file will have the same name as the template file with 
a .DIG extension.  
 
To view the report files, navigate to the report path and double click on the .DIG files. The report will be 
displayed in a table format. To plot the file with the specified line group double, click on the desired row. 

AUTOMATICALLY RENAME FILES 
The Automatically Rename Files feature monitors a folder for waveform/load files with user defined 
extensions. The files are renamed to the IEEE Long file naming format C37.232 ComNames Standard. 
 
When a file is detected in the source path or in its included folders it will first move the original file to the 
Archive path then read the file’s configuration information and rename the file to the destination path.  
 
To activate this feature, select the Auto Rename Files option under the Options menu/tab. A dialog will be 
displayed.  
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Enter the Source Path, click the Include Sub Folders check box if needed. Enter the Destination, Archive 
and Erro Paths. Any files that encounter a problem reading will be copies to the Error path. Enter all file 
extensions (*.DAT,*.CEV,*.CFF) and the scan period. If this feature needs to start when Wavewin runs, 
click the Automatically Start Auto Rename Files at Run Time checkbox. The bottom section of the dialog 
gives a status update on the activity of the process. It displays the last scan time, the original and 
Renamed filenames and when the next scan will start in minutes. To start the process, click the Start 
Rename button. Once the conversion starts the button caption will change to End Rename. To end the 
process, click on the End Rename button.  
 
To have the auto rename process started when Wavewin is run check the Automatically Start Auto 
Rename Files at Run Time check box. The conversion process is performed in the background. So, the 
dialog is not required to be open for the process to execute. To check the status of the renaming, open the 
dialog. The Next Scan In field reports how many minutes before the next scan is started. 
 

 
Figure 2.47  Automatically Rename Files Dialog 
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CREATE SER REPORTS 
The Create SER Reports feature monitors a folder for waveform files with user defined extensions. When 
a file is detected, it will read the file and create a comma delimited SER file from the digital channel 
activity. The SER file will have the same name as the original waveform file with a .SER extension. 

 

 
Figure 2.48  Automatically Create SER Files Dialog 

 
To activate this feature, select the Create SER Files option under the Options menu/tab. A dialog will be 
displayed. Enter the Source Path, click the Include Sub Folders check box if needed, enter the file 
extensions, such as (*.DAT,*.CEV,*.CFF), Enter the scan period. If this feature needs to start when 
Wavewin runs, click the Automatically Start Create SER File at Run Time checkbox. The bottom section of 
the dialog gives a status update on the activity of the process. It displays the last scan time; the original 
and SER filename being processed and when the next scan will start in minutes. To start the process, 
click the Start Create button. 
 
To create an SER file with all the digital activity from all processed Waveform files click on the Create a 
Combined SER File check box. Select or enter the path of the Combined file and enter its filename along 
with its extension. This allows for adding the SER information into a database from one single file. 
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To create the SER files for each file being processed by the Auto Process Templates add /SER to each 
line in the Format files being processed. 

APPEND CSV FILES 
The Append CSV files will append all the marked CSV files in the active folder that have the same number 
columns. The number of columns is determined by the first file marked in the File Manager. 

 

 
Figure 2.49  Append CSV Files Dialog 

 
To Append CSV files first marked all the files using the spacebar or mouse. Next, select the Append CSV 
files… menu option under the Options/Reports submenu. In the dialog select or enter the path for the 
combined file. Enter the filename and select to only save the file or to save and view the file in a table. 
Then click ok. To cancel the append click cancel. 
 
After all the files have been appended the final appended file can be displayed in the data plotting window. 
To plot the file double, click on the final CSV file. If it cannot be plotted, then it will be displayed in Excel. 

 

 
Figure 2.50  Append CSV Plotted 
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EXPORT FILE TABLE 
Export the contents of the File Manager’s table to a comma delimited CSV file. Select the path to save the 
file in and enter the filename. To export all the files in the table, click the All-Files radio button. To export 
only the marked files in the table click the Marked Files radio button. 

 

 
Figure 2.51  Export File Table 
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C H A P T E R  3  

Analysis Quick Start 
 
This chapter describes the main features of the Analysis Display. 

Analysis Features 
The Analysis Display offers a high-resolution graphical interface for displaying, analyzing, and manipulating 
analog and digital channels of an oscillography record or a periodic load file. Displayed channels can be 
marked, merged, appended, moved, zoomed, removed, restored, superimposed, scaled, numerically 
processed, exported, and summarized. A maximum of ten data windows can be opened at one time. 
 

 
Figure 3.1  Analysis Display 

 
The Analysis Display contains two sections: the analog view and the digital view. The analog view plots the 
oscillography or load data. The analog table displays values such as the channel’s highest peak, RMS, 
phase, reference, instantaneous, maximum, and minimum values. The cursor bars are used to view the data 
values. The digital view plots the events and sensors and displays the channel’s original state, the channel’s 
final state, time of the first change, time of the last change, and the number of times the channel changed 
state. 
 
Up to 256 analog and 5000 digital channels can be displayed in the window. A maximum of 10 data 
windows can be opened at the one time. The main features are described below. 

PHASORS  
The phasor diagram shows a vector for each visible analog channel. It also shows a vector at the 
reference bar for the first channel or the first marked channel if the option is selected. To show the vector 
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at the reference bar select one of the 3 options (Off, All, Marked) under the Ref Vectors drop down options 
under the Waveform tab. 
 
The vector diagram is displayed to the right of the analog information window. To increase or decrease the 
size of the phasor window place the cursor over the vertical separator between the analog information 
window and the phasor window and drag the mouse to the left to increase or to the right to decrease. To 
close the phasor window, click the close button located in the header. To reopen the phasor window, 
select the Phasor icon under the Waveform tab or position the mouse over the analog channel’s scrollbar 
displayed to the right of the analog channel table and move the mouse until the cursor becomes a double 
arrow. When the cursor changes to a double arrow drag the window to the left to reopen the window. 
 
To navigate the phase angles, use the left arrow, right arrow, home, end, page up and page down keys or 
the data scroll bar. To increase/decrease the length of a channel's vector, mark the channel and use the 
increase/decrease amplitude menu buttons or the Ctrl-Up and Ctrl-Down keys. To increase/decrease only 
the length of the vectors, use the up and down phasor buttons.  
 
To toggle between the phasor display and the circular chart display click the “P” button above the phasor 
display for phasors or the “C” button for a circular chart.  
 
There are two types of phasor displays: non-referenced and referenced. The non-referenced display 
shows the phase angle for each sample in the display. The reference display shows the phase angle for 
each sample with respect to the reference channel. The reference channel is the first marked channel in 
the window. All angles at a sample are subtracted from the reference angle. If there are no marked 
channels the non-referenced display is shown. 

 
Figure 3.2    (a) Non-Referenced Phasors       (b) Referenced Phasors 

HARMONICS 
The harmonics window displays as many harmonics as possible based on the file’s sampling frequency. A 
maximum of 200 harmonics can be displayed in the table. To display the harmonics window right click in 
the phasor diagram or in the analog information table and select the Harmonics menu option. The 
harmonics window displays the first marked analog channel or if no channels are marked, the first visible 
channel. Changing the marked channel in the data plotting window will update the harmonics window with 
the appropriate channel.  
 
The harmonic calculation is performed on a one cycle window, starting at the RMS bar, and going forward 
to the data bar. There are three fields displayed at the bottom of the harmonics table and histogram, 
TrueRMS, CalculatedRMS and Total Harmonic Distortion (THD). The TrueRMS field displays the RMS 
value calculated by using the samples in the active cycle displayed in the waveform trace window. The 
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CalculatedRMS field displays the square root of the summation of the squares of the DFT Magnitudes 
from harmonics 2 to the maximum harmonic divided by square root of 2. The maximum harmonic is the 
number of samples per cycle divided by 2. The THD field displays the square root of the summation of the 
squares of the DFT Magnitudes from harmonics 2 to the maximum harmonic and that quantity divided by 
the DFT Magnitude of the Fundamental.   
 
The harmonics can be viewed in a table format or in a histogram. Click on the harmonics toggle button 

 to change the view. The histogram can show only one column from the table. To change the data 
displayed click the histogram drop down menu and select the column. The default view is the % of 
Fundamental.  
 

. 
Figure 3.3  Histogram Drop Down Menu 

The harmonic histogram bars can be resized using the resize up and down arrows  to display 
more or less harmonics in the window. The text displayed above the histogram bars can be shown or 

hidden be clicking on the Show/Hide text bar button . The harmonics window can be resized by 
dragging the edge of the window to show more or less harmonics per window. 
 
Also, a vector for each harmonic is displayed in the phasor diagram, up to the 11th harmonic. To 
hide/show the harmonic vectors toggle the Vector Harmonics menu option under the View menu from 
checked=on to unchecked=off. 
 
The 0th harmonic represents the percentage of DC offset in the channel. 
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Figure 3.4  Harmonics Table View 
 

 
Figure 3.5  Harmonics Histogram View 

PERIODIC LOG FILES 
The periodic log viewer allows for viewing and analyzing large amounts of event data in a single display. 
The data is displayed in envelope form and may contain one day, one week, one month or one year of 
event data. This feature is useful for load flow analysis.  
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A circular chart of the data displayed in the trace window is plotted to the right of the channel information 
window. The circular chart cursor is positioned on the sample at the waveform data bar. The duration of 
the data displayed also is shown below the circular chart along with the sample number at the cursor bar. 
 
The ABB Load Profile and SDC log drivers are specific drivers used to view periodic log data. The 
COMTRADE format also displays log data. The ABB Load Profile format is an ASCII text file that contains 
time sequenced load information. The SDC Log format is an ASCII comma delimited CSV text file. The 
first line of the file is the header information. These files are generated from the Fault Data Concentrator 
(FDC).  
 

 
Figure 3.6  Periodic Log File 

CIRCULAR CHART 
The Circular Chart diagram shows a circular display for each visible channel. The diagram is displayed to 
the right of the analog information window. The amount of data displayed in the circular chart is equal to 
the amount of data displayed in the waveform trace window. The duration of the data displayed is shown 
at the bottom of the circular chart. To increase or decrease the size of the circular chart window place the 
cursor over the vertical separator between the analog information window and the circular chart window 
and drag the mouse to the left to increase or to the right to decrease. To close the circular chart window, 
click the close button  located in the header. 
 
To navigate the circular chart, use the left arrow, right arrow, home, end, page up and page down keys or 
the data scroll bar. The cursor bar on the circular chart displays where the data bar is in the plot. To 
increase/decrease the display area of a channel on the circular chart, mark the channel and use the 
increase/decrease amplitude menu buttons or the Ctrl-Up and Ctrl-Down keys or use the up and down 
arrow button  located in the circular chart header.  
 
Negative values in the circular chart are displayed with a small circle at each negative value. 
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Figure 3.7  Circular Charts 

DISPLAY DRIVER’S DATA TYPE 
The data stored in the displayed file can be instantaneous values or RMS values. The default setting for 
all drivers is instantaneous values. If the display driver saves the sample values as RMS calibrated, set 
the display driver’s data type to RMS Type (Root 2 Multiplier). If the display driver is not set properly the 
analog column data will be displayed incorrectly. To set the driver’s data type click the Window Properties 

 menu button from the speed bar or select the Properties icon under the Waveform tab. Click the Driver 
Data Type tab and set the Display Device’s Data Type field to RMS Type for RMS calibrated values and 
Peak Type for instantaneous values. 
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Figure 3.8 Analog Data Type Setting 

REOPEN WAVEFORM FILE 
To reopen a waveform file that was previously viewed click on the Open icon drop down list under the 
Waveform tab.  
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Figure 3.9 ReOpen Data File 

EMAIL ACTIVE FILE 
The active data file can be emailed by clicking on the email  menu button or by selecting Email icon 
under the Waveform tab. The data file in the active analysis window and all the support files associated 
with the file are included as attachments. The users default email program will be displayed to email the 
file(s). 

NAVIGATING 
Use the up and down arrow keys or the vertical scroll bar to browse the analog channels. The tab key 
toggles between the analog and digital views. 
 
The analog and digital values are displayed in a table to the right of the channel traces. Hold the mouse 
button down and drag the table separator bars to resize the viewing area. To view the analog sample 
values, use the following navigation tools: 
 

• Left and right arrow keys to navigate sample by sample. 
• Ctrl+left or ctrl+right keys to peak navigate. 
• Shift+ctrl+left or shift+ctrl+right keys to cycle hop. 
• Home and end keys to display the channel’s first and last samples. 
• Triangle  at the bottom of the data bar to drag the data bar through the samples. 
• Page up and page down keys to page through the samples. 
• Left button  displayed to the left of the data scroll bar to move the sample at the data bar to the 

position of the first sample displayed. 
• Left button  displayed to the right of the data scroll bar to move the trace and table separator to 

the position of the data bar. 
 
Click the left/right arrow button  (located to the right of the analog table headers) or use the shift-
right/left arrows to scroll through the analog table columns. Refer to the Viewing Analog Data section for 
field descriptions.  
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NOTE:  If no channels are marked then the peak navigate, and cycle hop features navigate through the 
first displayed channel’s data. 

SETTING THE CURSOR BARS 
Four vertical cursor bars are displayed in the analog view. The blue dotted line represents the reference 
bar, the black solid line represents the data bar, the black dotted line represents the RMS bar, and the red 
dotted line represents the fault position defined in the file’s configuration information. There are also two 
horizontal bars displayed when the Horiz Bars icon under the Waveform tab is selected.  

DATA BAR 
The data bar is displayed as a black solid line with a white triangle below the line. The position of the 
data bar is defaulted at the end of the first cycle in the data window when it is first displayed. To set the 
data bar’s position to 2 cycles after the trigger position select the Set Data Bar icon under the 
Waveform tab. 
 
To move the data bar use the left and right arrow keys to move one sample, use the Ctrl-left and Ctrl-
right keys to peak hop, use the Shift-Ctrl-left and Shift-Ctrl-right keys to cycle hop, use the page up and 
page down keys to move one page up or down or left click the mouse to move to any position in the 
data or drag the triangle to scroll through the data. When the mouse is held over the triangle a hint 
message displays the sample number at the data bar and the delta time from the first sample. The time 
of the sample at the data bar is displayed in the second status bar field. The channel values at the data 
bar are displayed to the right of the traces in the analog channel information table.  

REFERENCE BAR 
The reference bar is displayed as a blue dotted line. The reference bar is defaulted to the fault time 
specified in the file. To move the reference bar to the position of the data bar use the Set Ref Bar icon 
under the Waveform tab or press Ctrl-A. Click the opposite mouse button to move the reference bar to 
any position in the data area. The status field Delta X in the status bar at the bottom of the screen 
shows the time difference (in milliseconds or seconds) between the reference bar and the data bar. It 
also shows how many cycles are between the two bars. 

RMS BAR 
The RMS bar is displayed as a black dotted line. The RMS bar is defaulted to one cycle away from the 
data bar, except when the data bar is positioned at the beginning of the data. This bar is used for 
calculating the RMS value displayed in the analog information table. The RMS value in the analog table 
is calculated using all of the sample values displayed between the data bar and the RMS bar. To move 
the RMS bar to the position of the reference bar (blue dotted line) use the Set RMS Bar icon under the 
Waveform tab or press Ctrl-Z.  

FAULT BAR 
The fault bar is displayed as a red dotted line. The fault bar is fixed and positioned at the fault time 
defined in the file’s configuration information. The fault bar can be shown or hidden by selecting the 
“Yes” or “No” options for the Show Vertical Fault Bar field in the Properties dialog under the “Display 
Settings” tab. 

HORIZONTAL BARS 
When the Horiz Bars icon is highlighted under the Waveform tab two horizontal bars will be displayed. 
The solid black line follows the data bar, and the dotted blue line follows the reference bar. The bars 
will be positioned at the first marked analog channel (displayed in red), if no channels are marked, then 
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they are positioned at the first displayed channel. The Delta Y field in the status bar shows the 
difference between the two bars. 

 
To automatically resize the RMS sliding window click on the Sliding Win drop down list or open the Sliding 
Window dialog by clicking directly on the button. To manually resize the RMS sliding window click the 
opposite mouse button to set the reference position and the mouse button to set the data bar position then 
click the SetRMS icon. The RMS bar is moved to the reference position. The Delta X field displayed in the 
status bar at the bottom of the screen shows the time difference (in milliseconds or seconds) between the 
date bar and reference bar and the number of cycles between the two bars. Use the left, right, ctrl+left, 
and ctrl+right, shift+ctrl+left, and shift+ctrl+right keys or the horizontal scroll bar to move the sliding 
window. 
  

         
Figure 3.10 Resize Sliding Windows Drop Down Menus  

 

 
Figure 3.11 Resize Sliding Dialog for Waveforms  

 

 
Figure 3.12 Resize Sliding Windows Dialog for Log Files 

AUTO SET DATA BAR 
The data bar (black solid line) is by default positioned one cycle from the first sample when the window is 
first displayed. To change the default to be 2 cycles from the trigger position defined in the file select the 
From File Trigger Position option under the Set Data Bar drop down menu option under the Waveform tab. 
The second option is to position the data bar from the system calculated trigger position. 
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MARK AND SAVE 
The Mark and Save feature will save selected analog data to a user defined ASCII file using the selected 
template file. To open the Mark and Save window select the Mark Save icon under the Waveform tab. The 
window is divided into two sections. The top section displays the contents of the selected template file in a 
notepad editor and contains a drop-down list to select the template file. The list is initially populated with 
all the files that have a *.FMT extension located in the Wavewin directory. A browse button is available to 
add template files to the list that are not located in the Wavewin directory. To save a new template file, edit 
the contents of the existing template file, change the name of the file using the list box’s edit box then click 
the Save button. 

 
The bottom section displays the contents of the values file in a notepad editor and the location and name 
of the file. To save the analog data to a new file change the name of the file using the edit box or use the 
Browse button to create a new file, then click the Save button. 
 



Chapter 3 – Analysis Quick Start 

70 

 
Figure 3.13 Mark and Save Window 
 
The Apply Unit Prefix will multiply all analog values by 1000 if the values are in kilo. The truncate Values 
will save only integer values. 
 
The Use Default checkbox will write the visible analog columns to the Values notepad with a header for 
each column. 
 
Before savings values to an ASCII file the template files must be created. Refer to the next section on how 
to create a Template file. 
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TEMPLATE FILES 
To create a new template file clear the contents of the existing template file in the notepad editor, change 
the name of the template file using the list box’s edit box then click the Save button. To clear the contents 
of the Template notepad editor, mark the contents of the editor then press the delete key. 
 
To save any changes made to the active template file click the Save button. 
 
The template files use < > characters to define the available window commands and < > and [ ] characters 
define the analog commands. Review the Template Commands section for the supported Window and 
Analog commands.  
 
To add a header to the Values file, define the first line in the template file with <Header>= followed by the 
header information. For example, the following two lines define the header and data of the Values file: 
 
<Header>=  Station, Device, Date, Time, RMS, Angle 
<Station>, <Device>, <Date>, <Time>, <^1:R>, <^1:P>  
 
Any text not in the < > and [ ] characters get written to the Values file as they appear in the template file.  
 
Below is an example of a template file. 
 
% Initial Postfault Quantities 
 
save rect( <1> ) as P_Ia 
save rect( <2> ) as P_Ib 
save rect( <3> ) as P_Ic 
save rect( <4> ) as P_In 
save rect( <5> ) as P_kVa 
save rect( <6> ) as P_kVb 
save rect( <7> ) as P_kVc  
 
Results of the values saved using the above template when only the RMS and Phase columns are visible 
in the data plotting analog table. 
 
% Initial Postfault Quantities 
 
save rect( 1096.346,172.477 ) as P_Ia 
save rect( 577.000,24.181 ) as P_Ib 
save rect( 3168.159,38.157 ) as P_Ic 
save rect( 3024.967,50.501 ) as P_In 
save rect( 219759.479,328.716 ) as P_kVa 
save rect( 209623.595,209.628 ) as P_kVb 
save rect( 174040.116,78.700 ) as P_kVc 

TEMPLATE COMMANDS 
 

Window Commands 
<Station> Write the full Station name. 
<Station:12> Write the first 12 characters of the Station name. If less than 12 it pads blanks. 
<Device> Write the full Device name. 
<Device:6> Write the first 6 characters of the Device name. 
<Date:F> Write the Date at the data bar in the following format mm/dd/yyyy. 
<Time:F> Write the Time at the data bar in the following format hh:mm:ss.zzzzzz. 
<Date:U> Write the Date at the data bar in the following format yyyymmdd. 
<Time:U> Write the Time at the data bar in the following format hhmmsszzz. 
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<Cycles> Write the number of Cycles between the data bar and the reference bar. 
<DeltaX> Write the time difference between the data bar and the reference bar. 
<Line> Write the active Line name. 
<Data> Write if the data being processed is BAD or GOOD. This is determined by the 

size of the binary file compared with the calculated size using the total samples * 
scan size. 

<Remote> Write the Remote Feeder Name as defined in the Line Group, REMOTENAME=. 
<RDME> Write the Remote Station Name as defined in the Line Group, REMOTEDME=. 
<PHSROT> Write the Phase Rotation as defined in the Line Group, PHASEROTATION=. 
<SFreq> Write the sampling frequency at the data bar or reference bar. 
<LFreq> Write the line frequency. 
<LL> Write the Line Length. 
<Z1M> Write the Z1 Magnitude. 
<Z1P> Write the Z1 Angle. 
<Z0M> Write the Z0 Magnitude. 
<Z0P> Write the Z0 Angle. 
<Filename> Write the Filename displayed in the data plotting window. 
<Triggers> Write the number of triggers for the script commands. 
<Cktnum> Write the Circuit Name as defined in the Line Group as CKTNUM=. 
<Tobus> Write the To Bus Name as defined in the Line Group as TOBUS=. 
<Frombus> Write the From Bus Name as defined in the Line Group as FROMBUS=. 
<ReportFile> Write the name of the generated PDF report file. If there was no report file 

generated it writes NONE. 
 

Analog Commands 
< > Write the analog data at the data bar, 
[ ] Write the analog data at the reference bar, 
Number Writes the visible analog column data at the date bar separated by commas for 

specified Channel number. 
^Number Writes the visible analog column data separated by commas for the Channel in 

position 1. 
:A Write the average value for the whole channel. 
:C Write the RMS value for the last cycles in the file. 
:R Write the RMS value. 
:T Write the Channel Title. 
:U Write the Channel Unit. 
:P Write the Phase value. 
:I Write the Instantaneous value. 
:F Write the DFT magnitude for the specified Harmonic. For example, ^6:F0 writes 

the DFT Magnitude of the DC Offset for channel 6 and ^6:F2 writes the DFT 
Magnitude of the 2nd Harmonic for channel 6.  

:D Write the Duration of the Fault. 
:H Write the value DC Offset divided by the fundamental. Indicates a pegged 

channel. 
:X Write the CT ratio. 
:Y Write the PT ratio. 
:Z Write the frequency. 
:W Write the megawatts. 
:V Write the megavars. 
:% Write the Percentage of Nominal from the Prefault bar to the Fault bar.  
:%v Measures voltage sag immunity. 
:+ Write the channels maximum value. 
:- Write the channels minimum value. 
:Number Specifies the width of the analog data values. Will only be applied if the defined 

width is greater than the length of the data values. Spaces are padded to the 
beginning of the written values. This is used to right justify values. 
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:S The skew of the 3 analog channels using the angles. The S command is used 
with 3 analog channels <1,2,3:S>. This command adds the 3 angles at the cursor. 
One of the channels must be marked as a reference channel. 

:B The Unbalanced Value for 3 Channels. The B command is used with 3 analog 
channels <1,2,3:B>. This command finds the highest and lowest DFT magnitude 
of the 3 channels. The result is the highest – lowest. 

:N The Negative Sequence for 3 Channels. The N command is used with 3 analog 
channels <^1,^2,^3:N>. This command computes the negative sequence for the 3 
current or voltage channels in position 1, 2 and 3 on the screen. The magnitude 
for the negative sequence result is displayed. 

:Q The Positive Sequence for 3 Channels. The Q command is used with 3 analog 
channels <^1,^2,^3:Q>. This command computes the positive sequence for the 3 
current or voltage channels in position 1, 2 and 3 on the screen. The magnitude 
for the positive sequence result is displayed. 

:M The M command is used for an entire channel. It calculates the maximum value of 
the channel minus the minimum value of the channel divided by 2 ((max-min)/2), 
<^1:M>. Since the command is not sample based both types of brackets can be 
used (<>,[]).  

:SG100 
:BL50 
:NG5000 
:ML700 

The letter G or L followed by a number after the :S, :B, :M or :N defines a trigger. 
The letter G stands for greater than and L is less than. If the result is true than 
Alarm is displayed else Normal is displayed. 

 
Example Analog Commands 
<1> Writes the visible analog column data at the date bar separated by commas 

for Channel 1. 
<^1> Writes the visible analog column data separated by commas for the Channel 

in position 1. 
<1:R> Writes the RMS value at the data bar for Channel 1. 
<2:T> Writes the Channel Title for Channel 2. 
<^3:U> Writes the Channel Unit for the Channel in position 3. 
<4:P> Writes the Phase value for channel 4. 
<^5:I> Writes the Instantaneous value for the Channel in position 5. 
<6:F> Writes the DFT magnitude for Channel 6. 
[^1] Writes the visible analog column data at the reference bar separated by 

commas for Channel 1.  
<^1,^2,^3:S> Writes the sum of the angles at the cursor bar. One of the 3 channels must be 

marked as a reference channel. 
[^1,^2,^3:B] Writes the difference between the highest and lowest DFT magnitude at the 

reference bar. 
<^1,^2,^3:N:6> Writes the negative  
<^1,^2,^3:NG2000:7> Writes Alarm if the negative sequence of the 3 channels in position 1, 2 and 3 

is greater than 2000, if it is not greater than it writes Normal. 
<^1,^2,^3:NL500:7> Writes Alarm if the negative sequence of the 3 channels in position 1, 2 and 3 

is less than 500, if it is not less than it writes Normal. 
 
Digital Commands 

B1:T Writes the Breaker 1 Digital Channel Trigger Information as defined in the Line 
Group as Breaker1=. The output text is the Digital Channel Title/Start 
Second:Milliseconds/Duration. If the Digital Channel started in Alarm state then NA 
is defined as the start date. If the Digital Channel started in Alarm state or ended in 
Alarm state then NA is written for the Duration.  

B2:T Writes the Breaker 2 Digital Channel Trigger Information as defined in the Line 
Group as Breaker2=. The output text is the Digital Channel Title/Start 
Second:Milliseconds/Duration. If the Digital Channel started in Alarm state then NA 
is defined as the start date. If the Digital Channel started in Alarm state or ended in 
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Alarm state then NA is written for the Duration. 
E1:T Writes the Event 1 Digital Channel Trigger Information as defined in the Line Group 

as Event1=. The output text is the Digital Channel Title/Start 
Second:Milliseconds/Duration. If the Digital Channel started in Alarm state then NA 
is defined as the start date. If the Digital Channel started in Alarm state or ended in 
Alarm state then NA is written for the Duration. 

B1:S Writes A (Alarm) or N (No Alarm) indicating if the Breaker 1 Trigger status in the 
File. 

E3:D Writes the Event 3 Start Time  
B1:E Writes the total number of times the digital channel toggled. 

 
When a carat ^ is specified before the channel number it indicates the channel position in the data plotting 
window. The < > characters saves the analog data at the data bar and the [ ] characters saves the analog 
data at the reference bar. 

VALUE FILES 
To create a new values file click the Clear button to clear the contents of the existing values file in the 
notepad editor, change the name of the file using the edit box or click the Browse button to create a new 
file, then click the Save button.  
 
To write a template command to the values file, first position the data and/or the reference bar in the data 
plotting window then click the Mark button in the Mark and Save window or select the Mark Scan menu 
option under the Values menu in the data plotting window. You can also use the shortcut keys Ctrl-S to 
mark an analog scan in the data plotting window. Each command will be appended to the values notepad 
window. Click the Save button to save any changes to the template and values file. 
 
To navigate to the next Marked Scan in the data plotting window select the Next Marked Scan menu 
option under the Values menu or use the shortcut keys Ctrl-X to navigate to the next Marked Scan. 
 
The analog commands listed in the Template file section specifies what values to write to the values file. If 
the analog channel commands defined in the active template file does not specify a specific data value 
then all the analog columns visible will be saved with each command separated by commas. For example 
if the analog channel command is <1> and the INST, RMS and PHASE columns are visible then it will 
write the INST,RMS,PHASE values for Channel 1. 
 
If a specific analog channel is defined in the template file with no data value indicated and the channel is 
not visible then that template command is ignored. 

 
When a template command is written to the values file editor a red upside-down T is displayed above the 
analog scan in the data display window. To clear the red marks from the data display window select the 
Clear Marks icon under the Waveform tab. 

MARK SCAN 
To mark a scan, place the data bar at the desired scan then select the Mark Scan icon under the 
Waveform tab or press Ctrl-S. Marked scans are tagged with an upside-down red T at the top of the scan. 
Scans are also marked when the Mark button is clicked in the Mark & Save dialog. Marked scans are 
useful for navigating large amounts of data. To quickly navigate through the marked scans select the Next 
Marked Scan icon under the Waveform tab or press Ctrl-X. To clear the marked scans, select the Clear 
Marks icon under the Waveform tab. Marked scans can also be tagged with a comment. Refer to the next 
section for more information on assigning a comment to each scan. 
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EDIT MARKED SCANS 
To assign a comment to each marked scan select the Edit Marks icon under the Waveform tab. The edit 
marked scans dialog is displayed. The dialog lists each marked scan in a table with the following columns: 
 
Scan Sample Number – Displays the Scan Sample number with a checkbox to the left of the Sample #. 
Date & Time  – Displays the date and time of the scan. 
Comments  – Allows for entering a comment for each Marked Scan. 
 
The assigned comment can be viewed in the analysis window by placing the mouse over the scan’s 
upside-down red T indicator at the top of the window. The comment is displayed in a hint window. 
 
To delete a scan click the checkbox in front of the scan then click the Delete button. 
 

 
Figure 3.14 Edit Marked Scans 

MARKING, DELETING, AND RESTORING CHANNELS 
To mark or unmark a channel, mouse click on the channel ID or channel title, or use the space bar. To 
mark a group of channels click on the first channel then shift click on the last channel. Marked channels 
are displayed in red. 
 
To mark/unmark all analog and digital channels press the F8 key or select the Mark/UnMark All icon under 
the Channels tab. If no channels are marked, all of the analog and digital channels will be marked. If any 
channels are marked, all of the channels will be unmarked. To mark/unmark all the analog channels select 
the Analog Un/Mark icon under the Channels tab. To mark/unmark all of the digital channels select the 
Digital Un/Mark icon under the Channels tab. 
 
Channels must be marked to delete them from the display window. The Delete key removes the marked 
channels and the Insert key restores all the deleted channels. 

SCALING ANALOG CHANNELS 
When the analysis display is first opened, all the analog channels are scaled according to the channel’s 
units. To scale the channels according to the maximum space allocated for display, press F6 or click the 

AutoScale   icon. This option toggles among the four views: On, Off, ++ and Units. The active auto 
scale state is displayed in the “AS” status field. Each view is defined below: 
 

• ON – The On view plots the channel data scaled to the maximum value allocated along the zero-
reference line. 
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• OFF – The Off view plots all of the channels that are scaled to the maximum value in the display.  
• ++ - The ++ view plots the signal using the number of maximum pixels allocated for the channel. 

The highest value is plotted at the maximum position and the smallest value is plotted at the 
lowest position. This feature was added to clearly show the profile of a frequency channel, a Vdc 
channel and load data channels. 

• Units – The Units view plots the channels with reference to the maximum value allocated along 
the zero reference line for each group of channels with the same units.  

 
To increase or decrease a channel’s amplitude, along with the phasors and circular chart first mark the 

channels then click the AmpUp  or AmpDn  menus buttons or use the ctrl+up/down arrow keys. The 
auto scale multiplier (ASM) is used to amplify or attenuate the channel’s data values. For example, when 
the amplitude increases the ASM value is multiplied by the channel’s current Trace Multiplier and when 
the amplitude decreases the ASM value is divided by the channel’s current Trace Multiplier. The Trace 
Multiplier is located in the properties dialog under the Display Setting tab. This value is initially defaulted to 
1.75. To increase/decrease only the analog channels amplitude, click the up and down arrow buttons 

 located to the right of the data scroll bar. To increase/decrease only the phasor magnitude or 
circular chart click the up and down arrow buttons  located in the phasor/circular chart header.  

To increase or decrease the channel’s time scale, click the Condense  or Expand  icons or press 
the ctrl+page up and ctrl+page down keys. 
 
NOTE: If no channels are marked all the visible channels are scaled accordingly. 

ZOOMING CHANNELS 
To zoom in on specific analog or digital channels, first mark the channels then press <enter> or click the 
ViewMrks  icon. The unmarked channels are removed from the display window and the marked 
channels are rescaled to fit in the window. To restore the hidden channels press the <esc> key, the 
<backspace> key, or click the ViewAll  icon. 
 
When returning to the original view all channels in the previous view remain marked for quick selection of 
additional channels for a new view. 

SELECTING PREDEFINED VIEWS 
The DFR Transcan and Faxtrax records have predefined views encoded into their format. To select the 
predefined views click on the “Show All/ Select View” drop down icon  or select the Select View icon 
under the Waveform tab. A list of the available lines/graphs will be displayed. Click on the desired view. 
The analog channels defined in the select view will be displayed. To view all the analog channels in the 
file press the <esc> key, the <backspace>, or click the Show All icon or click the ViewAll  button. To 
view user defined views refer to the User Views section. 

                                           



Chapter 3 – Analysis Quick Start 

77 

Figure 3.15  Predefined Lines  Figure 3.16  Predefined Graphs 

REPOSITIONING CHANNELS 
Analog channels can be repositioned in the display window. To move an analog channel up one position 
mark the channel and press the “+” key or select Shift Up icon under the Channel tab. To move a channel 
down one position mark the channel and press the “-” key or select Shift Down icon under the Channel 
tab. To move a group of analog channels, mark all the desired channels then press the “+” or “-“ keys. 
 
The marked analog channels can also be moved by dragging the channels to a specific location in the 
display. To drag the analog channels to a new position move the mouse over one of the marked channels 
number or titles and drag to the specific position. 

PRINTING WAVEFORM FILES 
To print all of the data for the visible channels, select the All drop down option from the Print icon under 
the Waveform tab. The page numbers are located on the top right corner of each printout. The date and 
time of the first sample on each page is printed at the bottom left corner. To print only the data currently 
displayed in the data window click on the Page drop down option from the Print icon. To print a screen 
dump select the Window drop down option. Use the zoom feature to print only the selected channels. If 
the software cannot access the printer port, an error message is displayed. 

SAVING AS COMTRADE 
The visible analog and digital channels can be saved in the COMTRADE ASCII or Binary format. Three 
Comtrade versions are supported: the older 1991 format, the 1999 format and the newest 2013 format. 
The new 2013 Comtrade format can be saved as a single file with the CFG, HDR and DAT all contained in 
a single file. The new Comtrade single file format has a .CFF extension. The default format is the 1999 
ASCII format.  
 
Mark the analog and digital channels to save and press <enter> or click the ViewMrks icon . To create 
a COMTRADE file select the Save As icon under the Waveform tab. Enter the destination path and 
filename (do not enter the filename extension) and click OK. The “.DAT” and “.CFG” files or the “.CFF” file 
are automatically created. If a path is not defined, the COMTRADE files are saved in the active directory in 
the File Manager.  
 
To automatically name the Comtrade file using the IEEE long file naming format check the Use the 
ComNames Naming Convention to Name the Comtrade File(s) check box in the Save As dialog and leave 
the File Name field empty. The selected channels are converted to the specified Comtrade format and are 
named using the IEEE long file naming convention. 
 
If the sample values in the displayed file are RMS calibrated and the outcome Comtrade file must have 
instantaneous values, set the Comtrade Settings fields to automatically convert the RMS data to 
instantaneous values. To set the Comtrade Settings fields open the Properties dialog. Select the 
Comtrade tab then select “Yes” for the Convert RMS Calibrated Data to Peak Data field. 
 
If the line impedance values and line length are available in the original file then Wavewin will save the line 
impedance values to the .HDR file or in the .HDR section in the .CFF format. Below is an example of the 
information Wavewin saves in the header section of the Comtrade single file (.CFF). 
 
--- file type: HDR --- 
Fault Information 
01 - Event: BG  Location:    0.90  Shot:    Frequency:  60.03 
     Targets:  
     Currents (A Pri), ABCPGQ:    332  3660   316     2  3596  3580 
     Line Len:  3.08 
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Impedance Values 
Z1Mag = 2.84 
Z1Ang = 66.65 
Z0Mag = 8.81 
Z0Ang = 68.67 
LL = 3.08 
 

 
Figure 3.17  Save As COMTRADE 

VIEWING ANALOG DATA 
The values displayed in the analog view can be presented in tabular form (analog table) or in a 
concentrated form (combination view). Press F4 to toggle between the two views. The concentrated view 
can only be displayed if there is enough room to display 2 lines of data values between each channel. To 
navigate through the analog table columns use the View  button (located to the right of the analog table 
headers) or the shift-right/left arrow keys. To close the analog table, click the Close button located in the 
header. Valid analog channels are displayed in the left portion of the window and the analog information in 
the center table. An analog channel is marked as invalid if the title is empty, or it contains any of the 
following strings in the beginning of the title.  
 

• UNUSE 
• UNDEF 
• NOT D 
• NOT U 
• NOT I 
• NAT A 
• UNDEF 
• { 
• N/A 
• ANALOG INPUT 
• ANALOG CHANNEL 
• EXTERNAL INPUT 
• EVENT CHANNEL 
• CHANNEL 
• DIGITAL TRACE # 
• SPARE 

 
To show an invalid channel use the Show/Hide Channel Title dialog in the file manager. Refer to the 
Show/Hide Channel Title section for usage. 
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To make changes to the Analog and Digital views before opening a file, select the Display dialog located 
under the Options tab in the File Manager. Click on the Data Plotting tab. The table below explains each 
field available. 
 

Field Description 
Open View The Open View field when set to Yes will automatically 

open the first View located under the View  drop 
down list. 

Analog Table Font Size Change the size of the font in the Analog Table. The 
options are 8, 9, 10, 11, 12, 14, and 16. The default is size 
8. 

Digital Toggle Channels The Digital Toggle Channels option will only display the 
digital channels that have a change of state if set to Yes. 

Open Files w/ Primary Values The Open Files w/ Primary Values option will open all files 
with Primary Values if the Primary and Secondary values 
are in the data file. 

Process Type When processing batch files there are two ways the files 
can be processed, renaming each filename that was 
processed by adding a ,WWD to the end of the filename or 
by the save date of the file. If the save date is used the 
system first bins all the files to process then sorts them 
according to the earliest save date. The last save date 
processed is saved to the Wavewin.ini file. If a save date is 
in the Wavewin.ini then all files to be processed will start 
after the save date a time saved in the Wavewin.ini file.  

Batch Files When processing batch files (see the Auto Process 
Template section in the File Manager Quick Start) it will 
process all files or just the new files. When a file is 
processed a WWD is appended at the end of the filename. 
This indicates the file has been processed and it will not be 
re-processed if New Files is selected.  

Start DT Enter the Start Date and Time when processing files using 
the By Save Date selected in the Process Type field. 

Versioning The Versioning field applies to line group files. If a line 
group file exists (.LNG) then when a data file is open it will 
create an LPG file with the same name as the data file. 
This preserves the line group data for each data file.  

Process # Select the number of files to process for each run. The 
range is 1 to 256. 

PDF Files When the process templates engine processes a file a PDF 
screen dump and summary can be created for all the files, 
none of the files are just the files that had a breaker 
operate. Select the desired option from the drop down list. 

Convert If the files being processed in the process template engine 
have a date and time in UTC time this field will convert the 
UTC time to local time. 

Duration Calculation – Current The Duration Calculation Current fields allows for modifying 
the duration calculation. The duration is calculated for each 
current and voltage channel when the file is open. The 
current calculation is: If the 1st full cycle RMS value is less 
than set value (default = 100) then set the Trigger value to 
500 else set the Trigger value to the set value (default = 5) 
multiplied by the 1st full cycle RMS values. 

Duration Calculation – Voltage The Duration Calculation Voltage fields allows for modifying 
the duration calculation. The duration is calculated for each 
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current and voltage channel when the file is open. The 
voltage calculation is: If the 1st full cycle RMS value is 
greater than set value (default = 40) then set the Trigger 
value to entered percentage (default = 15%) multiplied by 
the 1st full cycle RMS values. 

Append ComNames Files This option will append all like files when a single file is 
opened. All appended files will be displayed in the data 
plotting window. The files must be in the IEEE long file 
naming format. Like files means the files have the same 
station name and same device name in the file names and 
the channel titles match in the files, 

 

 
Figure 3.18  Data Display Properties 

 
A maximum of 256 analog channels can be displayed in one window. The values displayed in the analog 
table and combination view are described below. 
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Analog Table View: 
The analog table view is the default view. Use the view button  or the shift-right/left arrow keys to 
navigate through the columns of the table. The original sample values are plotted according to one of the 
following data types: 
 

• Peak Type (No Multiplier) 
• RMS Type (Root 2 Multiplier)  
• Log files  

 
All of the display drivers in the system are defaulted to peak to peak except the predefined log drivers. To 
change the settings for a driver select the Properties icon under the Waveform tab. Click on the Driver 
Data Type tab and select the type from the Data Multiplier Type drop down list. Periodic Log File’s data 
type cannot be changed. To always open a certain display driver file with the RMS type, open the Driver 
Config dialog located in the File Manager’s Options tab. Select the display driver in the list box then set its 
Driver Data Type to the desired option. 
 
The following tables describe the analog data for the sinusoidal peak type, non-sinusoidal, and sinusoidal 
RMS data types:  
 
Peak to Peak 
Field Description 
Title The analog channel titles. 
RMS The TrueRMS value is calculated by taking the summation of the square of 

all the sample values that are between the RMS bar (black dotted line) and 
the data bar. The result is divided by the total number of samples between 
the two bars and takes the square root of that result. 

InstPeak The highest absolute value of all of the samples between the two zero 
reference crossings surrounding the data bar (black solid line). 

Phase The phase angle of each channel. 
InstVal The sample value at the data bar (black solid line). 
RefVal The sample value at the reference bar (blue dotted line). 
MaxPeak The maximum peak value of the channel. 
MinPeak The minimum peak value of the channel. 
Units The analog channels prefix and units. 
Scale The value in units per inch or centimeters. 
DFT Peak The DFT Magnitude calculated between the RMS bar (black dotted line) 

and the data bar (solid data bar). 
Crest The DFTMag column divided by the RMS column. 

 
Sinusoidal RMS Calibrated 
Field Description 
Title The analog channel titles. 
RMS The RMSVal column calculates an RMS value for all of the samples 

between the RMS bar (black dotted line) and the data bar (black solid line). 
Since the data is RMS calibrated each sample value is multiplied by the 
square root of 2 before it is squared. 

InstPeak The square root of 2 multiplied by the peak value measured between the 
two reference crossings surrounding the data bar (black solid line). 

Phase The phase angle of each channel. 
InstVal The RMS sample value at the data bar (black solid line) multiplied by Root 

2. 
RefVal The RMS sample value at the reference bar (blue dotted line) multiplied by 

Root 2. 
MaxPeak The RMS maximum peak value of the channel multiplied by Root 2. 
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Field Description 
MinPeak The RMS minimum peak value of the channel multiplied by Root 2. 
Units The analog channels prefix and units. 
Scale The value in units per inch or centimeters 
DFT Peak The DFT Magnitude calculated between the RMS bar (black dotted line) 

and the data bar (solid data bar). 
Crest The DFTMag column divided by the RMS column. 

        
Non-Sinusoidal (Load Files) 
Field Description 
Title The analog channel titles. 
MaxWin The absolute maximum value between the sliding window bar (black dotted 

line) and the data bar (black solid line). 
InstVal The sample value at the data bar (black solid line). 
RefVal The sample value at the reference bar (blue dotted line). 
MaxVal The maximum value of the channel. 
MinVal The minimum value of the channel. 
Units The analog channels prefix and units. 
Scale The value in units per inch or centimeters 
AvgWin The average value of all of the samples between the sliding window bar 

(black dotted line) and the data bar (black solid line) 
   
Combination View: 
The combination view shows all of the channel information in a signal view. This view is only available if 
there is sufficient room between analog channels to display two or more lines of text. 
 

Default Display format: 
 
Peak to Peak: 

Channel Title    
RMS MaxPeak RefVal  
InstVal MinPeak Units ASV 

 
RMS Calibrated:  

Channel Title    
RMS MaxPeak RefVal  
InstVal MinPeak Units ASV 

      
Load Files: 

Channel Title    
MaxWin MaxVal RefVal  
InstVal MinVal Units ASV 

 
The Instantaneous sample values are displayed in red when the data bar is on the channel’s maximum 
value and displayed in blue when the data bar is on the channel’s minimum value. Use the Tab key to 
toggle between the analog and digital channels. To hide the channel information, select the Analog Table 
icon under the Waveform tab. 
 
The analog table and combination views can be resized by selecting the vertical separator bar and 
dragging it to the right or left. The mouse icon changes to the vertical resize cursor when the mouse is 
positioned over the separator bar.  
 
To change how the analog data is displayed in the analog table and combination view select the 

Properties icon under the Waveform tab or click on the Properties   icon from the speed bar. The 
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Analog Table tab and the Analog Combination tab allows for changing the appearance of the analog 
information window.  
 
Some of the functions of the Properties dialog are reordering, hiding, and showing the analog table 
columns; changing the data positions in the combination view; changing the background colors and trace 
colors; and for changing the driver’s data type and trace/phasor scale multipliers.  

VIEWING DIGITAL DATA 
The default digital view consists of only the triggered digital channels, which are displayed at the bottom of 
the screen. Triggered digital channels are digital channel’s that have a value different than the original 
state saved in the channel’s definition file. If the field inside the Display dialog in the File Manager has the 
Digital Toggle Channel’s field set to Yes then only the digital channels that change state are displayed. To 
view all of the digital channels press F9 or select the All-Digital icon under the Waveform tab. A maximum 
of 4096 digital channels are displayed in a window.  
  
The digital trace is displayed as a thin black line when the sample value equals the original state defined 
in the displayed file and is displayed as a thick green line when the sample value differs from the original 
state. The color and spacing between the digital channels can be changed in the Properties dialog. The 
digital color is under the Color tab and the space between the digital is under the Display Settings tab. The 
Cursor State column in the digital table displays an “A” for Alarm and “N” for Normal or the SEL defined 
state. These values are set by comparing the sample value at the data bar with original state, “A” = 
different than original state, “N” = same as original state.  
 
The digital information is displayed in tabular form. The data columns are described below: 
 

Column 
Number 

Description 

1 – Cursor State The digital state of the sample at the cursor position (A=Alarm, N=Normal).  
2 – Title The channel title, a maximum of 40 characters can be displayed.  
3 – Fst The digital state of the first sample (A=Alarm, N=Normal).  
4 – Lst The digital state of the last sample (A=Alarm, N=Normal).  
5 – Fst-Change The time the channel first changed state.  
6 – Lst-Change The time the channel last changed state.  
7 – Changes The number of times the channel-changed state.  

 
Use the scroll bar or the up and down arrow keys to navigate through the digital channels and use the tab 
key to toggle between the analog and digital views. Digital channels can be moved up or down. To 
reposition digital channels first mark the channels using the mouse or the spacebar. Use the “+” key to 
move them up and the “–“ key to move them down. 

ANALOG CHANNEL SCALE 
The analog table displays the channels scale in inches or centimeters with respect to the units of the 
channel. The analog table column is Scale. The scale value is adjusted according to the current auto scale 
mode, OFF, ON, ++ or Units and is adjusted when the channel’s amplitude is increased or decreased.  
 
In auto scale mode OFF the scale is equal to the maximum value in the display. In auto scale mode ON 
the scale is set to the channel’s maximum value allocated for display from the zero reference line. In auto 
scale mode ++ the scale uses the channel’s maximum and minimum values allocated for display, ignoring 
the zero reference line. In Units mode all channels are scaled according to the maximum and minimum 
values for each group of channels with the same units.  
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CUSTOMIZING THE ANALYSIS DISPLAY 
The Properties icon under the Waveform tab allows for customizing the analysis display window. Below is 
a definition of each tab: 
 

• Analog Table – The Analog Table tab is used to reorder, hide, and show the columns in the 
Analog Table.  
 

• Analog Combination – The Analog Combination tab is used to change the position of the data 
values in the Combination view.  
 

• Comtrade – The Comtrade tab is used to define the Comtrade format for saving, the date and 
time format for display and for setting automatic conversion from RMS data to Peak data when 
using the Save As feature. It also allow for converting UTC to local time to support the new 2013 
Comtrade format,  

 
• Colors – The Colors tab is used to define the background colors of each display section and to set 

the default analog and digital channel colors.  
 

• Display Settings – The Display Settings tab is used to define the Scale Multiplier for the traces 
and phasor/circular chart scaling. It also can define general display information for the window 
such as: setting the display trace type (sample based or time based), defining the Phase Angle 
Convention (Sine or Cosine), showing the time reference bar between the analog channels and 
the digital channels, showing the separator bar between multiple events displayed in one window, 
showing or hiding the fault bar (red dotted vertical bar), and defining the option to reference angles 
across windows when Sync mode is active. When “Yes” is defined for reference angles across 
windows all phase angles for the currently opened windows will be referenced from the first 
marked channel in the active window.  

 
• Append / Merge – The Append/Merge tab is used to define from which file the samples will be 

discarded from when the discard common times option is used. It also is used to determine 
whether the station name should be added to the analog/digital titles when an append/merge 
option is executed. 

  
• Driver Data Type – The Driver Date type tab is used to define the type of data that is saved to the 

displayed device’s data file: RMS Type or Peak Type, convert the analog sample values between 
primary and secondary and for editing the ratio values and for changing the line impedance values 
from primary and secondary.  
 

• Filters – The Filters tab is used to define if spikes detected in the data file should be ignored when 
the maximum and minimum values are calculated and at what level they should be ignored.  

 
To make changes to the Analog and Digital views before opening a file, select the Display dialog located 
under the Options tab in the File Manager. Click on the Data Plotting tab. The table below explains each 
field available. 
 

Field Description 
Open View The Open View field when set to Yes will automatically 

open the first View located under the View  drop 
down list. 

Analog Table Font Size Change the size of the font in the Analog Table. The 
options are 8, 9, 10, 11, 12, 14, and 16. The default is size 
8. 

Digital Toggle Channels The Digital Toggle Channels option will only display the 
digital channels that have a change of state if set to Yes. 
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Open Files w/ Primary Values The Open Files w/ Primary Values option will open all files 
with Primary Values if the Primary and Secondary values 
are in the data file. 

Process Type When processing batch files there are two ways the files 
can be processed, renaming each filename that was 
processed by adding a ,WWD to the end of the filename or 
by the save date of the file. If the save date is used the 
system first bins all the files to process then sorts them 
according to the earliest save date. The last save date 
processed is saved to the Wavewin.ini file. If a save date is 
in the Wavewin.ini then all files to be processed will start 
after the save date a time saved in the Wavewin.ini file.  

Batch Files When processing batch files (see the Auto Process 
Template section in the File Manager Quick Start) it will 
process all files or just the new files. When a file is 
processed a WWD is appended at the end of the filename. 
This indicates the file has been processed and it will not be 
re-processed if New Files is selected.  

Start DT Enter the Start Date and Time when processing files using 
the By Save Date selected in the Process Type field. 

Versioning The Versioning field applies to line group files. If a line 
group file exists (.LNG) then when a data file is open it will 
create an LPG file with the same name as the data file. 
This preserves the line group data for each data file.  

Process # Select the number of files to process for each run. The 
range is 1 to 256. 

PDF Files When the process templates engine processes a file a PDF 
screen dump and summary can be created for all the files, 
none of the files are just the files that had a breaker 
operate. Select the desired option from the drop down list. 

Convert If the files being processed in the process template engine 
have a date and time in UTC time this field will convert the 
UTC time to local time. 

Duration Calculation – Current The Duration Calculation Current fields allows for modifying 
the duration calculation. The duration is calculated for each 
current and voltage channel when the file is open. The 
current calculation is: If the 1st full cycle RMS value is less 
than set value (default = 100) then set the Trigger value to 
500 else set the Trigger value to the set value (default = 5) 
multiplied by the 1st full cycle RMS values. 

Duration Calculation – Voltage The Duration Calculation Voltage fields allows for modifying 
the duration calculation. The duration is calculated for each 
current and voltage channel when the file is open. The 
voltage calculation is: If the 1st full cycle RMS value is 
greater than set value (default = 40) then set the Trigger 
value to entered percentage (default = 15%) multiplied by 
the 1st full cycle RMS values. 

Append ComNames Files This option will append all like files when a single file is 
opened. All appended files will be displayed in the data 
plotting window. The files must be in the IEEE long file 
naming format. Like files means the files have the same 
station name and same device name in the file names and 
the channel titles match in the files, 
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TIME & SAMPLE BASED DISPLAYS 
The Trace Display Type field located in the Display Setting tab of the Properties dialog allows for toggling 
between the Time Based display and the Sample Based display. The sample based display plots the 
channel data with one pixel distance between each displayed sample. Sample based displays are useful 
for showing changes in sampling frequency. The time based display plots the channel data in time. Time 
based displays are useful for showing changes in line frequency. 
 
To change the trace display type open the Properties dialog under the Waveform tab. Click the Display 
Settings tab and change the Trace Display Type field to time based or sample based. 

FAULT REFERENCE TIME BAR 
The Fault Reference Time Bar is displayed between the analog and the digital traces. It displays the time 
difference from the fault time defined in the displayed file. The units are displayed in the Delta X status 
field. 
 
To toggle between the Timeline display and the Ruler display right click on the time bar and select from 
the pop up menu. 
 
To show or hide the fault reference time bar open the Properties dialog under the Waveform tab. Click the 
Display Settings tab and select “Yes” or “No” for the Show Reference Time Bar field. 

SUPERIMPOSING ANALOG CHANNELS 
To superimpose two or more analog channels, mark the channels and press F7 or select the Super 
Impose On icon under the Data tab. Multiple groups of channels can be superimposed in one display. To 
superimpose the current channels mark the channels then press F7. The channels will automatically be 
unmarked after a superimpose operation. Next, mark the voltage channels and press F7. If no channels 
are marked and the channels are superimposed then all channels will be un-superimposed, Press F7 to 
turn this feature ON/OFF or select the Super Impose Off icon. 

CHANGING ANALOG CHANNEL COLORS 
To change the color of an analog channel, click the opposite mouse button on the channel ID. Select the 
channel color from the list or click More Colors to select from the color palette. Channels must be 
unmarked to change their colors. 

SYNCHRONIZING DATA CURSORS 
The Sync Data Cursors feature is used to synchronize the data bars for two or more display windows. To 

synchronize two or more data bars, open the files, select Tile Horizontal icon  from the main toolbar, 
then select the Sync drop down icon under the Data tab. This feature offers two sync functions: By Time 
and Manually. When a function is selected, the data bars in the non-active windows are moved to the 
synchronization point of the active window. The two functions are described below: 
 

By Time 
When the time function is activated, the data bars in the non-active windows are moved to the sample 
time of the data bar in the active window. For example, if the data bar in the active window is positioned 
on a sample at time 01:12:34.5600 all of the non-active data bars are moved to the sample at that time. 
If the time cannot be found the data bar does not move. 
 
Manually 
The manual sync function allows for the selection of different cursor positions in the windows before 
synchronization is activated. For example, open four display windows and tile horizontally. Move the 
data bar to the beginning of the fault cycle in each window and select the Manual cursor sync function. 
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Press the left arrow, right arrow, ctrl+left, ctrl+right, page up, page down, ctrl+page up, ctrl+page down, 
home and end keys or use the scrollbar or drag the triangle located under the data bar to move the 
data bars. 
 

 
Figure 3.19  Cursor Synchronization 
 
In Sync Mode, phase angles can be referenced across analysis display windows. The phase angles in the 
opened data windows are referenced by the first marked channel in the active data window. This feature is 
activated from the Properties dialog under the Display Setting tab in the Sync Mode section. Sync Mode 
must be active for the angles to be referenced. 

APPEND OPEN FILES 
The Append drop down icon under the Waveform tab appends all of the open windows into a new display 
window. There are two options available under the Append drop down icon: 

• Discard Common Times: Any common times found in the open files will be deleted from the oldest 
file. 

• Back to Back: The files are appended back to back. No samples are deleted. 
 
When the system appends files it first finds the file with the oldest date and time. It then checks that all 
other opened files analog and digital channel titles and the scale factors for each analog channel match. If 
any of these do not match them the file is not included in the final appended display. When a file does not 
match a message box is displayed indicating the file will not be included in the waveform display.  

MERGE OPEN FILES 
The Merge drop down icon under the Waveform tab merges all of the displayed or marked channels into 
one display window. There are three options available under the Merge Open Files Menu: 
 

• By Time: Merge channel samples if they have a common time segment. The reference time is 
taken from the file with the latest start date and time. The file with the least number of samples 
determines the length of the new merged file. 
 

• Manually:  Use the data bars to highlight the location of the common sample time in each window. 
Then Merge Manually will line up the data bars and adjust the time stamps accordingly. This 
option is used when the file times are not synchronized. The active window determines the time 
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stamp of the new merged file and the open window with the least number of samples determines 
the length of the new merged file. 

 
• By Sample:  Merge without regard to time stamps and/or data bar positions. The reference time is 

taken from the active window. The file with the least number of samples determines the length of 
the file. 

 
When files with different sampling frequencies are merged a dialog will be displayed. The dialog contains 
a list of all the sampling frequencies in the opened files. Select the frequency for the merged file or enter a 
new frequency. 
 

 
Figure 3.20  Merge Open Files: Select Frequency 

 
Merging Open Files allows for flexibility of which channels are merged. Merge will merge the marked 
channels only, if there are no marked channels then it will merge the visible channels. 
 
If the merged files have different data types (RMS Calibrated or Peak Values) the RMS values will be 
automatically converted to Peak values by multiplying the RMS values by Root 2. 
 
To identify the merged channels the station name for each file is added to the beginning of the analog and 

digital channel titles. To turn this feature off open the Properties dialog . Click on the Append/Merge 
tab and uncheck the Add the File’s Station Name to Beginning of the Analog/Digital Channels field. 
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Figure 3.21  Append/Merge Properties 

 

 
Figure 3.22  Merge Open Files – By Time: Open files and select channels to Merge 
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Figure 3.23  Merge Open Files – By Time: Result: By Time 
 
Merge Open Files “By Time” will only merge the samples with common times. The reference time is the 
file with the latest start date and time. 
 

 
Figure 3.24  Merge Open Files – Manually: Select Channels & Position Data Bars 
 
First, select the channels to merge by marking the channels and pressing the <enter> key. Next, position 
the data bars at the point representing the Same Point in time. 
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Figure 3.25  Merge Open Files – Result: Manually 
 
Merge Open Files Manually is used when the file times are not synchronized. Place the data bars in the 
position where the times should be synchronized and merge the files. Merge will align the samples 
according to the position of the data bar in each open file. The data bar with the least number of samples 
at the beginning determines the number of samples to truncate from the beginning of all other open files. 
The active window’s time stamp is used for the merged file and the open file with the least number of 
samples determines the length of the merged file. 
 

 
Figure 3.26  Merge Open Files – Result: By Sample (As Applied to Figure 3.23) 
 
Merge Open Files “By Sample” merges without regard for time stamps and/or data bar positions. It 
merges “as is”. The reference time is from the active window and the file with the least number of samples 
determines the length of the file. 
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CHANGE FREQUENCY 
Change Frequency changes the current sampling frequency to the entered frequency. If the entered 
frequency is greater than the current frequency then samples are added. If the entered frequency is less 
than the current frequency then samples are deleted. The following screen dumps show an example that 
sets a multiple frequency file to a single frequency. The entered frequency must be greater than two times 
the line frequency. 
 
Select the Sampling icon under the Data tab to open the change sampling frequency dialog. 
 

 
Figure 3.27  Change Frequency Dialog 

 
It also allows for defaulting a driver to always display its’ files using the entered frequency. For example, 
all SEL 4 samples/cycle (240ƒs) files can be set to automatically display 40 samples/cycle (2400ƒs). 
 
NOTE:  If Open Frequency is checked the Restore Original is not available. 
 

 
Figure 3.28  Change Frequency: Change a Mutiple Frequency File 
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Figure 3.29  Change Frequency: Results 

TRUNCATE CYCLES 
Truncate Cycles removes the specified number of cycles from the analysis display. Three options are 
available under the Truncate drop down icon under the Data tab.. 
 

• Left: Remove all cycles from the first sample to the data bar.  
• Right: Remove all cycles from the data bar to the last sample. 
• Middle: Remove all cycles from the data bar to the reference bar (blue dotted line). 

 

 
Figure 3.30  Truncate Cycles: Append Non Time Matching Waveforms 
 
After appending two waveform files it may be necessary to truncate the cycle that did not match. First, 
align the reference bar on the peak before the appended position then align the data bar on the peak 
following the appended position and select the truncate middle menu option. 
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Figure 3.31  Truncate Cycles: Results 

DUPLICATE CYCLES 
The Duplicate Cycles dialog duplicates the cycle at the data bar by the number of times entered in the # 
Cycles field. This feature is useful for creating Comtrade files to play back to test set and for modeling and 
simulation applications. Refer to the following screen sumps for an example that adds five cycles of fault 
cycles to a file. 
 
To open the Duplicates dialog select the Duplicate icon under the Data tab. 
 

 
Figure 3.32  Duplicate Cycles Dialog 
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Figure 3.33  Duplicate Cycles: Initial File 
 

 
Figure 3.34  Duplicate Cycles: Add 5 Fault Cycles 

RESTORE ORIGINAL DATA 
Restore Original Data will reread and display the sample values from the active waveform file on disk. Any 
changes made to the analysis window, such as: duplicate cycles, change frequency and truncate cycles 
will be lost when this feature is activated. If the Open Frequency option is checked in the Change 
Frequency dialog the Restore Original is not available. To restore the display to the original samples in the 
file click on the Original icon under the Data tab. 

MARK RAW VALUES 
Mark Raw Values marks the raw values saved in the active waveform file on disk. A small hollow blue 
circle is placed at the raw value. This feature is helpful in highlighting the raw sample values saved in low 
sampling rate files. To mark the raw samples click on the Mark Raw icon under the Waveform tab. 
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Figure 3.35  Mark Raw Values 

MARK PEAK VALUES 
Mark Peak Values marks the peak sample values for all visible analog channels. A small solid gray square 
is placed at the peak values. This feature is helpful in highlighting the positive and negative peak values. 
To mark the peaks click on the Mark Peaks icon under the Waveform tab. 
 

 
Figure 3.36  Mark Peak Values 

MARK CHANGE IN SIGN VALUES 
Mark Change In Sign marks all samples where a change in sign occurs. A small solid gray triangle is 
placed at the change position. This feature is helpful in highlighting the position where a change in sign 
occurs in the signal. To mark the change in sign positions click on the Mark Change icon under the 
Waveform tab. 
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Figure 3.37  Mark Change in Sign 

CHANGE ANALOG VALUES (PRIMARY   SECONDARY) 
The values displayed in the analog table are either in primary or secondary quantities. The analog 
quantities type is displayed in the window header. Also, if the CT and PT ratios are defined in the 
configuration file the values can be changed from primary to secondary and vice versa. To change the 
values open the properties dialog and click on the “Driver Data Type” tab and select the Primary or 
Secondary radio button to switch between values. 
 

 
Figure 3.38  Type of Analog Values Displayed 
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Figure 3.39  Change Analog Values (Primary  Secondary) 
 
The CT and PT ratio values can be edited by clicking on the Edit Ratio Values button in the Driver Data 
Type tab. The values are listed in a table format for each analog channel. The modified ratio values are 
not saved to the original file. To save the edited ratio values use the Save As option under the Waveform 
tab. 
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Figure 3.40  Ratio Values 

ADJUST FILES DATE & TIME 
The Adjust Files Date & Time allows for adjusting the date and time of the open file. To open the Adjust 
File Time dialog, click on the Adjust Files Time Icon under the Data tab. You can specify to add or subtract 
a given date or time increments from the files current date and/or time. Enter the desired time increment 
for the year, month, day, hour, minutes, seconds, and milliseconds. If there is no adjustment needed on a 
specific time field enter 0. 
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Figure 3.41  Adjust Files Date & Time 
 
To always have the file's time automatically adjusted when a specific driver is used to open a file check 
the Adjust Open Time check box. 
 
To show the file’s original date and time click on the Original icon under the Data tab. 

CREATING VIRTUAL CHANNELS (SACS & SDCS) 
The analysis window allows for ten software analog channels (SAC) and eight software digital channels 
(SDC). These additional virtual channels exist only in RAM. The sample values are created using a 
function of the existing analog/digital channels. Predefined operators can be used to calculate a missing 
phase, create positive/negative and zero sequence channels; convert channels to secondary or primary 
values; calculate V/I for fault resistance/impedance, multiply, divide, add and subtract multiple channels; 
multiply, divide, add and subtract channel data by a constant value; create an envelope of an analog 
channel; define over-trigger or under-trigger values; calculate a missing phase; define the prefix and unit 
for the channel; or perform bit-wise ANDing/ORing on digital traces. 
 
All calculations are designed to operate "on the fly". For the forward looking SAC operator ("@" some 
positive angle) care must be taken. Upon opening a file and while the system is reading the data samples, 
the forward samples are not available. In that case, the system uses the current sample instead of the 
requested forward sample. To execute forward looking SAC instructions, wait until the file is read and 
displayed, use F5 to recalculate. 
 
SAC title and operators can be saved to an ASCII text file on disk by using the Save and Save As buttons 
located to the right of the SAC operators. The Open button allows for opening existing SAC files without 
having to manually enter the SAC titles and operators. These features are useful for reusing existing SAC 
operations on like files. The New button clears the existing SAC title and operators. 
 
The SAC and SDC instructions are composed of an operator and an operand. An operand can be a 
channel defined by the channel number or a constant. Constant values must have a “^” operator before 
each value to distinguish between channel numbers and constant values. To phase shift analog channels, 
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use the “@” sign before each angle defined. All angles must be defined in degrees. Following is a list of all 
the software operators that are available: 
 

• “+” - Add (Analog),  
• “-“ - Subtract (Analog),  
• “*” - Multiply (Analog),  
• “:” - Divide (Analog),  
• “^” - Constant value (Analog),  
• “@” - Phase Shift (Analog),  
• “e” - Adjusted envelope (Analog),  
• “a” - Envelope (Analog),  
• “<” - Under-trigger (Analog),  
• “>” - Over-trigger (Analog),  
• “h” - Harmonic for Channel (Analog), 
• “h=” - Harmonic for all Back Operations (Analog), 
• "x" - real component (Analog),  
• "y" -imaginary component (Analog),  
• "m" -magnitude (Analog),  
• "d" -angle (Analog), 
• "r" -true RMS (Analog),  
• "f" -cyclic frequency (Analog),  
• "q" -instantaneous frequency (Analog), 
• "t" -delta time frequency (Analog), 
• “s” - sin operator (Analog),  
• “c” - cos operator (Analog) 
• "b" -operate between bars only (Analog),  
• “|” - Absolute Value (Analog), 
• “p=” - Prefix (Analog),  
• “u=” - Unit (Analog),  
• “+” - And (Digital),  
• “.” - Or (Digital),  
• “/” - Instruction terminator (Analog & Digital)  

 
NOTE: All SAC/SDC operations are performed in Reverse Polish Notation (one operation at a time). 
The instruction set must always terminate with a “/”. An operation error is generated if the instruction 
formats are not followed.  
 
Operators are formatted as a stacked set of instructions. To select from the predefined fast SACs click on 
the drop down list then double click on the desired SAC. The name of the SAC is in the first column and 
the operator is in the second column. To have the SAC name automatically copied to the SAC title click on 
the Set SAC Titles using Fast SAC headers check box. The position of the channel in the operators is 
marked by a Pound Sign #. If there are any marked channels in the data plotting window then the fast 
SAC will be populated with the marked channels number. For example if channels 4, 5 and 6 are marked 
and the Calculate Neutral fast SAC is selected then the Operator will be displayed as: +4/+5/+6/u=A/. If 
there are no channels marked the operator will be +#/+#/+#/u=. The user will have to replace the # with 
the desired channels and complete the unit.  
 
An instruction is composed of four attributes:  
 

1. The operator: +, -, *, :, ...  
 

2. The operand: channel index (1, 2, 3, ...) or constant value (such as ^3.14)  
 

3. The function: @, h, x, y, m, d, f, ...  
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4. Instruction terminator: / 

 
Press F5 to display the SAC dialog or select the SACs icon under the Channels tab. To display the SDC 
dialog select the SDCs icon under the Channels tab. Below are some examples: 
 

Operations Example Description 
Addition +7/+8/+9/ Add channels 7, 8, & 9 and store the result in 

the SAC. 
Subtraction +7/-8/-9/ Subtract channel 8 from channel 7 and store 

the result in the SAC then subtract channel 9 
from the SAC and restore the values in the 
SAC. 

+ Sequence +1/+2@120/+3@240/:^3/p=k/u=volt/ Calculate the + sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

- Sequence +1/+2@240/+3@120/:^3/p=k/u=volt/ Calculate the - sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

0 Sequence +1/+2/+3/:^3/p=k/u=volt/ Calculate the zero sequence components and 
store the result in the SAC then set the SAC’s 
prefix and unit. 

Harmonics +16/h=1/p=k/u=volt/ Extract the 1st  Harmonic component from 
Channel 16 and store in the SAC then set the 
SAC’s prefix and unit. 

Multiplication +3/*^2.66/ Multiply all sample values in channel 3 with 
the constant value 2.66 and store the result in 
the SAC. 

Division +7/:3/ Divide all samples values in channel 7 by the 
sample values in channel 3 and store the 
result in the SAC. 

Half Cycle 
Envelope 

+2/e/ Calculate the half cycle envelope of channel 2 
and store the result in the SAC. 

Envelope +12/a/ Calculate the envelope of channel 12 and 
store the result in the SAC. 

Under-trigger +4/<135/ Store all the sample values from channel 4 
that are < 135 in the SAC. 

Over-trigger +62/>500/ Store all the sample values from channel 62 
that are > 500 in the SAC. 

Absolute Value +7/+8/+9/|/p=k/u=Volts/ Add channels 7, 8, & 9 and store the absolute 
value of the result in the SAC then set the 
SAC’s prefix and unit. 

Frequency +7f/u=Hz/ Store the cyclic frequency of channel 7 and 
set the SAC’s unit to Hertz. 

Frequency +7q/u=Hz/ Store the instantaneous frequency of channel 
7 and set the SAC’s unit to Hertz. 

Magnitude +11m/u=V/p=k/ Store the magnitude of channel 11, and set 
the SAC’s unit to Volt and the prefix to k. 

Real +4x/+5x/+6x/u=V/ Store the real components of the fundamental 
of 4, 5 and 6 and set the SAC’s unit to Volts. 

Imaginary +4/+5/+6/y2/u=V/ Store the imaginary components of 2nd 
harmonic of 4, 5 and 6 and set the SAC’s unit 
to Volts. 

Secondary +1/:^3000/u=V/ Store channel 1 values divide by 3000 and set 
the SAC’s unit to V. 
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Operations Example Description 
Impedance 
(V/I) 

+4/:6/h=1/u=mho/ Store the fundamental of channel 6 (V) 
divided by channel 1 (I) and set the SAC’s unit 
to mho.  

Differential 
Current 

+1/+2/+3/+4/|/u=A/ Store the absolute value of the sum of 
channels 1 2 3 and 4 and set the SAC’s unit 
to A. 

Apparent 
Power (1=V, 
4=I) 

*1m/*4m/p=k/u=Watts/ Store the magnitude of channel 1 multiplied 
by the magnitude of channel 4 and set the 
SAC’s prefix to k and the units to Watts. 

Power Factor +1d/-4d/c/u=Deg/ Store the cosine of the angle of channel 1 
minus the angle of channel 4 then set the 
SAC’s unit to Deg.  

Active Power +1d/-4d/c/*1m/*4m/p=k/u=Watts/ Calculate the cosine of channel 1 angles 
minus channel 4 angles, then store the 
calculated value multiplied by channel 1 
magnitudes and channel 4 magnitudes, set 
the SAC’s prefix to k and the unit to Watts.  

Reactive Power +1d/-4d/s/*1m/*4m/p=k/u=Vars/ Calculate the sine of channel 1 angles minus 
channel 4 angles, then store the calculated 
value multiplied by channel 1 magnitudes and 
channel 4 magnitudes, set the SAC’s prefix to 
k and the unit to Watts. 

AND +2/.33/ AND channel 2 with channel 33 and store the 
result in the SAC. 

OR +2/.4/+14/ AND channel 2 with 4, then OR the result with 
channel 14 and store the result in the SAC.  
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Figure 3.42  SAC Dialog 
 

 
Figure 3.43  SAC Results  
 
Engineers can use the additional channels as a generic tool for monitoring or modeling tasks. A virtual 
channel can be used to compute one of the phases of a monitored line by adding the remaining phases 
then subtracting the result from the residual channel. This in turn frees up a hardware channel for other 
monitoring needs. 
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The SAC operators and titles can be saved to an ASCII text file on disk to save time when re-entering 
SAC operator and titles. The SAC files can have any filename, but the extension must be .SAC. If an 
extension is entered when saving a SAC file then the extension is deleted and .SAC is added to the 
filename. The active SAC path and filename is displayed in the first status field. The second status field 
indicates if the SAC title or operator fields were modified. 
 
There are 4 options for the SAC files, Open, New, Save and Save As. Each option is explained below: 
 

SAC File Operator Description 
Open Open an existing SAC file. The Window’s open file dialog is displayed. 

Navigate to the desired folder and double click on the SAC file. The SAC 
title and operator fields are populated with the contents of the selected file. 
If the file is not a valid SAC file then an error message is displayed.  

New Clear the current SAC title and operators and change the SAC filename in 
the first status field to Untitled. If the previous SAC title and operators where 
modified then a message will be prompted asking to save the existing SACs 
before clearing the fields. 

Save Save the active SAC title and operators to the SAC file listed in the first 
status field. If the SAC filename is listed as Untitled then the “Save As” 
dialog is displayed.  

Save As Save the existing SAC title and operators to a new SAC file. The Window’s 
“Save As” dialog is displayed. Navigate to the desired folder and enter the 
new name in the “File name” field and click the “Save” button or press enter.  

 

 
Figure 3.44  Open SAC File  

PLAY CHANNELS AUDIO 
It is now possible to hear the characteristics of a signal through the analysis window. To play the audio of 
a specific analog channel first mark the channel. Then open the Analog Channel Audio dialog by clicking 
on the Play Audio icon under the Data tab. The Analog Channel Audio dialog is displayed in the bottom 
right hand corner of the analysis window. 



Chapter 3 – Analysis Quick Start 

106 

 

 
Figure 3.45  Play Audio Dialog   

 
The Active Channel section displays the analog channel marked in the analysis window. The Audio 
Controls section allows for playing the active analog channel’s data through the computers speakers and 
for increasing/decreasing the volume of the output. The Save .WAV File section allows for saving the 
analog channel data in the Window’s .WAV format. Click the folder button  to select a destination folder 
and to enter a new “.WAV” file or for selecting an existing “.WAV” file. The selected folder and filename will 
be updated in the Audio Filename field. 
 
To view the saved “.WAV” file exit the analysis window, navigate to the “.WAV” folder and double click on 
the wave file. A new display driver was added to plot Microsoft’s “.WAV” files.  

ALIGN CHANNEL DATA 
The Align Channel Data option aligns the analog channel samples according to the defined phase shift 
angles. The alignment routines use the Thiran 3rd Order All Pass Fractional filter. The all-pass delay 
guarantees no magnitude deterioration and fractional because delays can be a fraction of the sample 
interval. 
 
To align the analog channels manually click on the Align icon under the Channel tab. If the Thiran filter 
has already been applied to the displayed analog channels a message is displayed.  
 

 
Figure 3.46  Align Channel Message   
 
To continue to the Align Channel Data dialog click “Yes”. To apply the filter to the file’s original unfiltered 
data click “No” or “Cancel”. Then select the Original icon under the Data tab. 
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The Align Channel Data dialog applies the Thiran filter according to the entered Phase Shift angles. Enter 
the phase shift angle for each analog channel. If the filter does not apply to a specific analog channel 
enter 0 or leave the field blank or enter NONE. To display the coefficient values used for each analog 
channel click the “Calculate Coefficients” button. The “A0, A1, A2 and A3” fields will be updated with the 
coefficients for the entered phase shift angles.  
 

 
Figure 3.47  Align Channel Data Dialog   
 
To always apply the Thiran filter on files for the active driver click the Always Apply check box. Always 
apply automatically runs the Thiran filter with the defined phase shift angles before displaying the file. To 
display the files original samples click the Original icon under the Data tab. 
 
The coefficients used for the filter can be edited. If the coefficients are modified click the Use Entered 
Coefficients Values radio button. To have the coefficients automatically calculated when the filter is 
applied click the Calculate Coefficients at Run radio button.  

USER VIEWS 
User Views allow for saving and displaying specific information about a selected view. When a view is 
saved the following information is saved to an ASCII text file in the user defined folder. 
 

• Displayed analog channels, 
• Analog channel order, 
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• Superimposed channels, 
• Analog channel colors, 
• Digital channels displayed, 
• Sampling frequency, 
• Time scale, 
• Sliding window size (RMS bar to Data bar), 
• Phasor window size, 
• Table window size, 
• Red fault bar, 
• Auto scale and 
• Phasor or circular chart displayed 

 
To save a view, first set up the desired view. Then click on the Save View icon under the Waveform tab. 
The Save View dialog is displayed. 
 

 
Figure 3.48  Save View Dialog 
 
Enter the view’s name in the View Name field and select or enter the destination folder into the View File 
Path field. By selecting the destination folder, it is possible to save a hierarchy of views that allows for 
easy access to specific views according to the user’s preference. The channels to save can be 
manipulated in the Analog and Digital tables. To also save a print profile view, check the Save a Print 
Profile checkbox. Click the orientation type and header type. A short header will print the basic file 
information listed in the Waveform Summary window. The Advanced header will print the basic file 
information, analog and digital information from the Waveform Summary window. 
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To select a view open the view drop down menu. The drop down menu lists the last seven saved/selected 
views. If the view is not listed click on the “More View” option to open Microsoft’s select file dialog. 
Navigate to the view’s folder and double click on the view file.  
 

 
Figure 3.49  Select View Drop Down Menu 

 

 
Figure 3.50  Select View File Dialog 
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To view the details of a saved view before selecting it, open the Select View dialog from the Waveform 
tab. The select view dialog has four sections. On the left side of the dialog is the list of all the available 
views located in the displayed view path. To change the view path either use the browse button or select a 
previous navigated directory from the View Path drop down list. Under the view files is the window’s 
settings defined in the file. On the right side is the view information for each analog channel and digital 
channel in the view. 
 
A number of manufactures save the lines contained in a DFR record in the header format of the file. The 
Transcan, Faxtrax, Director, USI and APP recorders save the line definitions in the header section of the 
file. These predefined lines are listed in the top section of the view drop down menu. For Transcan, 
Faxtrax and Director recorders the line definitions are defined in the proprietary header files. For USI and 
APP the line definitions are stored in the Comtrade .HDR file. The HDR files are located in the 
manufactures install path. To define the location of the USI and APP line definition files open the Drive 
Configuration dialog. Refer to the Device Configuration section in the File Manager Quick Start. Select the 
USI Comtrade Files or the APP Comtrade Files under the Drivers list box. On the right hand side enter the 
path for the line definition files in the Driver’s Line Directory field. 
 

 
Figure 3.51  Select View Details Dialog 
 
Double click on the view file or select the file and click “OK”. If the analog channel and digital channel 
names defined in the view file are not in the displayed file then an error message is displayed. To exit the 
dialog without selecting a view, click on the Cancel button. 

SINGLE ENDED FAULT LOCATION CALCULATOR 
The single ended fault location calculator calculates a single ended Fault Location. The single ended 
calculator has four types of calculators: Radial Line Method, Reactance Method, Multi-Phase and Three 
Phase.  
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To open the single ended fault location calculator, select the Single Ended Icon under the Data tab. To 
convert the line Z1 and Z0 fields from primary to secondary and vice versa click on the arrow next to the 
Positive Sequence definition and select the multiplier from the drop down list for the Line Impedance 
Multiplier field.  
 
The single ended calculator is a stay on top window which allows for changing the position of the data bar 
while the dialog is open. When using the cursor keys to move the data bar make sure the data window is 
the active window.  
 
Radial Line Method: 
To calculate the radial line method click on the Radial Line Method tab. Select the faulted voltage channel 
from the V Channel Number drop down list and select the faulted current channel from the I Channel 
Number drop down list. Next, enter the Z1 and Z0 magnitude and angle. If the Z1 and Z0 values are 
stored in the opened file then these fields will be automatically populated.  
 
The magnitude and angle for Vf and If are read from the data bar position in the selected open window. To 
change the position of the data bar, click on the desired location in the waveform window. The data values 
will be automatically populated, and the fault location is updated. To update the fault location click on the 
Calculate button.  
 

 
Figure 3.52  Single Ended Fault Calculator: Radial Line Method 
 
Reactance Method: 
To calculate the reactance method click on the Reactance Method tab. Select the Voltage fault channel 
from the V Channel Number drop down list, select the faulted current channel from the I Channel Number 
drop down list and select the neutral channel from the N Channel Number drop down list. Next, enter the 
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Z1 and Z0 magnitude and angle. If the Z1 and Z0 values are stored in the opened file header then these 
fields will be automatically populated.  
 
The magnitude and angle for Vf, If and IN are read from the data bar position in the selected open 
window. To change the position of the data bar, click on the desired location in the waveform window. The 
data values will be automatically populated, and the fault location is updated. To update the fault location 
click on the Calculate button. 
 

 
Figure 3.53  Single Ended Fault Calculator: Reactance Method 

 
Multi-Phase Method: 
To calculate the multi-phase method click on the “Multi-Phase” tab. Select the two faulted voltage 
channels from the Vf1 Channel Number and Vf2 Channel Number drop down lists, select the two faulted 
current channels from the If1 Channel Number and If2 Channel Number drop down lists. Next, enter the 
Z1 and Z0 magnitude and angle. If the Z1 and Z0 values are stored in the opened file header then these 
fields will be automatically populated.  
 
The magnitude and angle for Vf1, Vf2, If1 and If2 are read from the data bar position in the selected open 
window. To change the position of the data bar, click on the desired location in the waveform window. The 
data values will be automatically populated, and the fault location is updated. To update the fault location 
click on the Calculate button. 
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Figure 3.54  Single Ended Fault Calculator: Multi-Phase Method 
 
Three-Phase Method: 
To calculate the three-phase method click on the Three-Phase tab. Select the three faulted voltage 
channels from the VA, VB and VC drop down lists, select the three faulted current channels from the IA, IB 
and IC drop down lists. Next, enter the Z1 and Z0 magnitude and angle. If the Z1 and Z0 values are stored 
in the opened file header then these fields will be automatically populated.  
 
The magnitude and angle for VA, VB, VC, IA, IB and IC are read from the data bar position in the selected 
open window. To change the position of the data bar, click on the desired location in the waveform 
window. The data values will be automatically populated, and the fault location is updated. To update the 
fault location click on the Calculate button. 
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Figure 3.55  Single Ended Fault Calculator: Three-Phase Method 
 
Plot the Single Ended Fault Location: 
To plot the fault location in the data plotting window as a new channel, click on the drop down arrow in the 
plot button. The two options are plot the fault location between bars or plot the fault location for the entire 
record. The default option of the plot button is plot between bars. Between bars plots the fault location 
between the data bar and the reference bar. 
 

 
Figure 3.56  Single Ended Plot Button 

 
Before plotting the fault location between bars make sure the data and reference bar are positioned on the 
proper samples in the data plotting window. 
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Figure 3.57  Single Ended Plot Radial: Channel 18 

DOUBLE ENDED FAULT LOCATION CALCULATOR 
The double ended fault location calculator calculates a double ended Fault Location using the two open 
fault records (near and far ends). The near end is the top left window displayed. To reorganize the 

windows use the Tile buttons . To open the double ended fault location dialog click on the Double 
Ended FL Icon under the Data tab. 
 
The double ended fault location dialog is first displayed in the summary mode. The summary mode has 
the basic input fields (ZL and line length) along with the fault location results. To expand the window to 
show the details of the fault location click on the Show Details button. 
 

 
Figure 3.58  Double Ended Fault Calculator: Summary Window 
 
If the fault location is based on the summary window then the channels in each record must be organized 
as follows: the first 3 visible channels are the voltage channels, VA, VB and VC. The next 3 visible 
channels are the current channels, IA, IB and IC. To reposition the analog channels first mark the 
channels then use the plus key to move the channels up one position and the minus key to move the 
channels down one position or drag the channels to the proper positions. If the channels are not organized 
as listed then click the Show Details button and change the channel numbers using the drop down list to 
the left of the channel labels. 



Chapter 3 – Analysis Quick Start 

116 

 
The values populated in the dialog are read at the data bar positions from both open records. The double 
ended dialog is a stay on top window. This allows for repositioning the data bars without closing the 
dialog. To refresh the Voltage and Current values in the dialog use the Refresh button. 
 
To increment the voltage and current angles for the near end and far end enter an increment value in the 
angle rotation fields and click on the Rotate button. This allows for a more accurate fault location when the 
results angle is closest to zero. 
 
Use the Calculate button to calculate the double ended fault location. 
 

 
Figure 3.59  Double Ended Fault Calculator: Details 
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Plot the Double Ended Fault Location: 
To plot the fault location in the data plotting window as a new channel, click on the drop down arrow in the 
plot button. The two options are plot the fault location between bars or plot the fault location for the entire 
record. The default option of the plot button is plot between bars. Between bars plots the fault location 
between the data bar and the reference bar. 
 

 
Figure 3.60  Double Ended Plot Button 

 
Before plotting the fault location between bars make sure the data and reference bar are positioned on the 
proper samples in the data plotting window. 
 

 
Figure 3.61  Double Ended Plot: Channel 19 
 
The action for each button in the double ended fault location dialog is listed below: 
 

Button Image Description 

ZL Settings 
 

 
 

The ZL settings button displays the ZL settings for the two 
open records. A red ! symbol is displayed next to the button 
if the ZL settings do not match.  

Refresh  
 

Refresh the data values from both open records and 
calculate the fault location. 

Calculate  
 

Calculate the double ended for the data values at the 
cursor position. 

Plot  
 

Plot the double ended fault location for the top displayed 
record (near end). Plot between bars or for the entire 
record. 
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Report  

Opens an edit window with a textual report of the double 
ended fault location information. See the Double Ended 
Fault Location Report for more information. 

Close  
 

Close the double ended fault location window. 

Show/Hide Details  
 

Show/Hide the details section of the double ended fault 
location window.  

Composite 
 

 
Doubles the Line Data magnitude.  
 

Rotate  
 

Rotate the Angles to get as close to zero as possible. 

Auto Scale  
 

Turn Auto Scale On/Off for the Phasors diagram.  

Up Arrow  
 

Increase the Phasors by a multiplier of 2. 

Down Arrow  
 

Decrease the Phasors by dividing by 2. 

 
Double Ended Fault Location Report: 
The Report button will display a textual report with all the information contained in the doubled ended fault 
location dialog. The report is editable and can be saved under a new name using the Save As button 
located to the right of the File name field. 
 
The report contains six sections: 
 

• Double Ended Fault Location: This section list the fault location in percent of line length for both 
ends of the line. 

• Line Impedance Data: This section lists the Line Impedance magnitude and angle. 
• Convergence Data: This section lists the method used for the fault location : negative, positive or 

zero sequence, near side angle and far side angle.  
• Fault Resistance Data: This section lists the magnitude and angle of the Voltage zero sequence, 

Current of the near end plus the current of the far end and voltage divided by the current. 
• Near Side File Information: General Information about the near side file. 
• Far Side File Information: General Information about the far side file. 
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Figure 3.62  Double Ended Fault Location: Report 

SEQUENCE COMPONENTS CALCULATOR 
The sequence components calculator calculates the zero, positive and negative sequence components for 
the data values at the data bar for the active window (single) or for two open windows (end to end).  
 
The channels in the active records must be organized as follows: The first 3 visible channels are the 
voltage channels, VA, VB and VC. The next 3 visible channels are the current channels, IA, IB and IC. To 
reposition the analog channels first mark the channels then use the plus key to move the channels up one 
position and the minus key to move the channels down one position or drag the marked channels to the 
proper position. If the channels are not organized as suggested then the channel numbers can be 
changed directly in the dialog using the drop down lists to the left of the channel labels. 
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The values populated in the dialog are read at the data bar positions in the open records. The sequence 
calculator dialog is a stay on top window. This allows for repositioning the data bars without closing the 
dialog. To refresh the voltage and current values in the dialog use the Refresh button.  
 
Use the Calculate button to calculate the sequence components. To increment the voltage and current 
angles enter an increment value in the Angle Rotation field and click on the Rotate button.  
 
To open the sequence calculator dialog select the Sequence Calculator Icons under the Data tab. 
 

 
Figure 3.63  Sequence Components Calculator Dialog – Single End 

 
To always use the displayed channels that are selected in the voltage and current drop down lists when 
opening the Sequence Components Calculator use the checkbox, “Always Use Displayed Channels”. This 
will always preselect the analog channels when opening the sequence components calculator if they 
exists in the file.  
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Figure 3.64  Sequence Components Calculator Dialog – End to End 

SAVE AS: CSV FORMAT 
The save as CSV format allows for  saving specific analog information into a CSV comma delimited 
format. There are four options under the Save As Comtrade dialog Save As Type drop down list: RMS 
Values, Instantaneous Values, Vector Values (Magnitude and Angle) or Vector Values (RMS and Angle).  
 
The first line in the CSV file is the header information for each channel. All the analog channels displayed 
in the active data plotting window are saved.  
 
A dialog box is displayed to enter the destination path and the filename. The destination path is 
automatically defaulted to the active path in the file manager. The filename can be directly entered into the 
File Name field, or the file can be automatically named using the IEEE C37.232 long file naming format. 
To have the file automatically named click on the ComNames check box. If the ComNames check box is 
checked then the File Name field will be disabled. To enter a file name make sure the ComNames check 
box is unchecked. 
 

The four Save As CSV options are: 

• Save As CSV - RMS Values: Save the RMS Values in a comma delimited format.  
• Save As CSV - Instantaneous Values: Save the Instantaneous Values in a comma delimited format.  



Chapter 3 – Analysis Quick Start 

122 

• Save As CSV - Vector Values (Mag & Angle): Save the DFT Magnitude and Angle in a comma 
delimited format.  

• Save As CSV - Vector Values (RMS & Angle): Save the RMS Value and Angle in a comma 
delimited format. 

 
Figure 3.65  Save As: CSV Format Dialog 

 
The Save As CSV dialog fields are described below:  

 
• Path: The path field is automatically defaulted to the active path in the Wavewin file manager. To 

change the “Path”, enter a new path in the edit box or click on the browse button  to select an existing 
path. 
 

• File Name: Enter the file name in the edit box. The file name edit box is only active for input if the Use 
the ComNames Standard to Name the file check box is unchecked. To save the file using the IEEE 
C37.232 long file naming format click on the Use the ComNames Standard to Name the file check box. 
 

• Use the ComNames Standard to Name the File: The Use the ComNames Standard to Name the file 
check box will automatically assign the file name using the IEEE C37.232 long file naming format. If the 
check box is checked then the file name field is disabled. 
 

The file format saved is a comma delimited text file and the .CSV extension is automatically assigned. The 
first line in the file defines the header information. The first two columns are the samples date and time. 
Below is an example of the header: 
 
DATE(0/DATE),TIME(1/TIME),IA(4/Amps),IB(4/Amps),IC(4/Amps),VA(4/Volts),VB(4/Volts),VC(4/Volts) 
 
All files saved using the Save As CSV format are recognized as plotting files using the SDC display driver. 
Wavewin will automatically recognize the saved format and display it in the data plotting window.  
Below are screen dumps of some of the Save As CSV options. 
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Figure 3.66  Save As: CSV Format - RMS Display 
 

 
Figure 3.67  Save As: CSV Format - Vector Display 

HARMONIC ANALYSIS REPORT 
The harmonic analysis report runs the harmonic calculation on each channel from harmonics 0 (dc-offset) 
to the maximum harmonic (samples per cycle/2). To run the harmonic analysis report, select the Harmonic 
Analysis Report Icon under the Data tab. When selected the Harmonic Analysis dialog is displayed. Enter 
the harmonics above the percentage of fundamental to report on, the number of amps below to ignore 
during the analysis and the number of voltage below to ignore, Press the Run Report button to start the 
analysis. 
 
The final report is an ASCII text file. The top section list the summary information for the file. The analysis 
report is in a table format and lists the following columns:  
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• Harmonic number,  
• Date and Time the harmonic was first detected,  
• Sample number the harmonic first detected,  
• Magnitude at the Sample number (DFTPeak),  
• Fundamental,  
• Percentage of the fundamental,  
• Duration how long the harmonics was detected.  

 

 
Figure 3.68  Harmonic Analysis Dialog 

 

 
Figure 3.69  Harmonic Analysis Report 
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TVE CALCULATOR 
The TVE (Total Vector Error) calculator is used to calculate the TVE for synchro phasor measurements.  
TVE is defined as the square root of the difference squared between the real and imaginary parts of the 
theoretical actual phasor and the estimated phasor. The equation used in the calculator is from the IEEE 
C37.118-2005 Standard, Equation # 2.  
 
The TVE is calculated on the first displayed channel or the first marked channel. To mark channels, use 
the spacebar or mouse. Marked channels are displayed in red. 
 
To open the TVE calculator select the TVE Icon under the Data tab. Once selected the TVE dialog is 
displayed.  
 
The TVE dialog is a stay on top dialog allowing for the data bar to be moved in the data window while the 
dialog is open. When using the cursor keys to move the data bar make sure the data window is the active 
window. To populate the Measured values with the values at the data bar click the Refresh button. Enter 
the Actual values then click the Calculate button to show the TVE between the Actual values and the 
measured values. Click the Close button to close the dialog. 
 

 
Figure 3.70  TVE Calculator 

FREQUENCY CALCULATOR 
The frequency calculator is used to measure the frequency between the reference bar and the data bar. 
To open the frequency calculator, select the Frequency Calculator Icon from the Data tab. Once selected 
the Frequency dialog is displayed in the upper right corner of the data plotting window.  
 
The frequency dialog is a stay on top dialog allowing for the data bar to be moved in the data window 
while the dialog is open. When using the cursor keys to move the data bar make sure the data window is 
the active window. The Delta X values will be automatically updated when the data bar is moved in the 
data plotting window. Enter the number of cycles between the reference bar and data bar then click the 
Calculate button to show the frequency value. The number of cycles is displayed in the status bar in the 
Delta X field. Click the Close button to close the dialog. 
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Figure 3.71  Frequency Calculator 

SEMI F47-0706 VOLTAGE SAG CHART 
The SEMI F47-0706 Voltage Sag display shows the sag immunity chart. The chart depicts the required 
voltage sag ride-through capability curve. The unaffected region is the green area, and the miss operation 
region is the red area. 
 
To view the chart, click on the SEMI F47 option from the Channels menu/tab. If no channels are marked, 
the first 3 voltage channels will be automatically selected. 
 
To the right of the chart is the sag percentage which is calculated for each voltage channel using the 
following equation: (Nominal RMS *100) / (Lowest Sag RMS). Each displayed percentage is followed by 
the channel number, the duration in milliseconds and the number of cycles. 
 
The trigger value for the duration calculation is set in the System Settings dialog. The default setting is 
15% of nominal. 
 
The F47 plot will adjust according to the amount of time in the file.  
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Figure 3.72  Duration Calculation – Voltage  
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Figure 3.73  SEMI F47 0706 Voltage Sag Chart with 1 second of data and 4 seconds of Data 
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3-D PLOTS 
The Plot 3-D feature plots a maximum of 3 channels in 3-D. To plot the channels in 3-D first mark the 3 
channels then click on the Draw 3-D icon under the Channels tab. Viewing channels in a 3-D fashion 
allows for viewing power flow.  
 
To open the 3-D Plot chart first mark the channels then click on the Draw 3-D icon under the Channel tab. 
 

 
Figure 3.74  Plot 3-D 

 
To the right of each channel is the channel number, the channel title, the instantaneous maximum and 
minimum values of the entire channel and the duration of the fault in cycles and milliseconds. The 
calculation for the duration is defined in the Display dialog located in the File Manager’s Options tab. The 
values used in the duration calculation can be edited. The trigger values for the duration calculation are 
set in the System Settings dialog. The default setting is 15% of nominal for the voltage channels, and 
times 5 of nominal per unit for the current channels. 

ROSE PLOTS 
The Rose charts feature plots the waveform signal using the circular charts. To plot a rose chart, first mark 
the channels to plot then hit enter to isolate the channels. Next, click on the C button above the phasor 
diagram. The rose charts display a small circle the same color as the signal color if the value is a negative 
value. To return to the phasor display click on the P button above the rose chart.  

 

 
Figure 3.75  Rose Plots 
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DIGITAL CHANNEL GROUPS 
To save digital groups in a view use the Save View dialog. When a record is open, Wavewin will only 
display the digital channels that changed state. When creating digital groups all of the digital channels 
may have to be displayed prior to opening the Save View dialog. Before opening the Save View dialog 
select the All-Digital icon under the Waveform tab. This will include all of the digital channels in the Save 
View dialog. 
 
The Digital Groups section is disabled until the New Group button is clicked. To create a digital group, use 
the Mouse to select the digital channels in the Digital Channel’s list box. Next, click on the New Group 
button. Once the New Group button is clicked the Digital Group section will be enabled and the Digital 
Group Name field will have the focus. Type in the name of the new group and hit enter or click the Save 
button. The table below the Digital Group Name field will be populated with the name of the digital groups 
in the first column and the number of channels in that group in the second column. 
 

 
Figure 3.76  Save View – Digital Groups 
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Figure 3.77  Select View 
 

 
Figure 3.78  Digital Group Drop Down Menu 
 
In the Data Plotting window select the View that was saved with the Digital Groups. A new drop down 
button is added to the Data Plottting main toolbar. The new drop down lists all the Digital Groups in the 
View. To display a digital group select the group from the drop down menu. By default Wavewin only 
displays the triggered digital channels for each group. To view all the digital channels in the group click on 
the All Digital icon under the Waveform tab. 
 
A View can also be selected from the Select View Dialog. Click on the Select View icon under the 
Waveform tab. When the view is selected under the View Files section a new list is displayed next to the 
Digital Channel list box. It lists all the Digital Group Names and if the digital group is compatible with the 
displayed file. The group is compatible if it’s digital number and name in the group match the digital 
channels name and number in the file. 
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Figure 3.79  Select View Dialog 

AUTO PLAY WAVEFORM 
The Auto Play Waveform will play the waveform as an oscilloscope. In the ribbon system there are three 
buttons on the main toolbar and under the Data tab to Start/Stop the waveform and increase and 
decrease the speed of the waveform. In the menu system use the 3 menu options under the Data menu, 
Play Waveform, Decrease Speed, and Increase Speed. The Play Waveform will auto play the displayed 
analog and digital channels, phasors and any other dialogs open such as the harmonic window, Sequence 
Components window and the Power Harmonic Calculator. The analog and digital channels will move to 
the left keeping the data cursor fixed at one cycle from the beginning of the display. In the Ribbon system 
the button to the left of the auto play button is used to slow the speed of the waveform movement and to 
the right is a button to increase the speed of the waveform. In the Menu System use the menu items 
increase/decrease to control the speed of the waveforms. 
 
All values in the tables and dialogs are the values at the data bar.  
 
The Auto Play Waveform does extensive drawing to the screen. To minimize flicker and slow drawing 
select a maximum of 7 channels and expand the time scale to see a smooth transition when the analog 
channels are played. The drawing is done in the background. This allows for marking, deleting, expanding, 
contrasting, scaling channels and more while the Waveform is being played. 
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Figure 3.80  Auto Play Waveform 

 

    
Figure 3.81  Auto Play Waveform Menu Buttons 

SORT DIGITAL CHANNELS 
The Sort Digital Channels will sort the displayed digital channels according to the first change of state. 
This feature will sort the first change in state in Ascending order or sort the first change in state in 
Descending order. There is also an option to restore the order of the Digital Channels when the file was 
first opened. In the menu system use the submenu under the Channels menu called Sort Digital Channels 
and in the ribbon system use the drop down menu in the Channel tab under the Arrange section. 
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Figure 3.82  Sort Digital Channels Ascending Order 
 

 
Figure 3.83  Sort Digital Channels Descending Order 

RESTORE ORIGINAL VIEW 
The Restore Original View will restore the analog channels, digital channels, phasors, and the analog 
table back to the original view when the file was first opened. To restore the original view select the 
Restore Original View menu option under the View menu in the Menu system or click the Restore Original 
View icon in the View section under the Waveform tab in the Ribbon System. 
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 Figure 3.84  Restore Original View Menu Options 

INVERT MARKED CHANNELS 
The Invert Marked Channels will invert all the marked analog channels. To activate, first mark the desired 
analog channels using the spacebar or mouse. Next, right click on the analog channel table and select the 
Invert Marked Channels menu option. If there are no analog channels are marked then this option will be 
disabled. 
 
All of the marked channels scale factor will be multipled by -1. To restore the original, mark the channels 
again and select the popup menu option Invert again. 
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Figure 3.85  Invert Marked Channels Popup Menu 
 

 
Figure 3.86  Inverted Analog Channels 

SEL SPECFIC VIEWS 
The SEL Specfic Views allows the user to save a view for each type of SEL Relay. The view can also be 
automatically applied when the SEL files are opened. To create the SEL views first select the SEL file in 
the File Manager. Next open a summary of the file by selecting Summaries under the Options Tab/Menu. 
The Device Type listed  under the File Information section shows the name of the SEL view file. 
 
* File Information: 
* ------------------ 
            Station: MCC 202 
             Device: MCC SUB 
          File Name: C:\FAULTLIB\TEST\150428,070428709,-5,Station,SUB,Comp,AG,-XY.CEV 
          File Size: 92496 Bytes 
      Prefault Time: 4/28/2021 07:04:28.629834 
         Fault Time: 4/28/2021 07:04:28.709000 
          Save Time: 04/29/2021 07:47:06 
       Process Time: 08/05/2022 13:36:37 
  Start Date & Time: 04/28/2021 07:04:28.629834 
    End Date & Time: 04/28/2021 07:04:29.692334 
      File Duration: 1  Sec(s) - 62 Mils(s) - 500 Mics(s) 
 Sampling Frequency: 240.000000, 4166.667  Microsecond Rate 
     Line Frequency: 60.000000 
        Device-Type: SEL-751A  
 
In the above summary the SEL view must be named SEL-751A.VIW. To set up the view open the SEL file 
in the Data Plotting Window.  
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Figure 3.87  Open SEL File 
 
Once the file is open setup the view. 
 

 
Figure 3.88  Setup SEL View 
 
In the view above the voltage channels where moved to the top. The VS, VBAT and FREQ channels 
where deleted. Each channel was assigned a color and the sampling frequency was increased from 240 
samples per second to 2400. The 3 voltage channels where super imposed and the 3 phase currents 
where super imposed. The analog channel table was resize to show Title, InstVal, RMS, Phase and Units. 
To move the analog table columns open the Properties dialog and select the Analog Table tab. 
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Figure 3.89 Properties Dialog/Analog Table Tab 

 
When the View is complete select the Save View menu option under the Waveform tab. 

 

 
Figure 3.90 Save View Dialog 

 
Enter the SEL Device type displayed in the Summary window: SEL-751A. The extension is not needed. It 
will be automatically assigned the .VIW extension. Select the path where the View will be saved in the 
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View File Path field. All SEL view files can be saved in a single path accessible to all Wavewin users. To 
set the path where Wavewin will look for the SEL view files select the Driver Config menu option under the 
Options tab in the File Manager.   

 

 
Figure 3.91 Driver Configuration Dialog 

 
Set the Driver’s Header Directory to the path where the SEL View files are saved. Set it for both the SEL 
Long and SEL Short drivers. 

 
To have the view automatically opened when and SEL file is opened select the Display Properties menu 
option under the Options tab.  
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Figure 3.92 Display Properties Dialog 

 
Select the Data Plotting tab. Change the first field, Open View, in the General Settings section to Yes.  
This setting will apply the SEL Views when the files are opened. 

OPEN CFG FILE 
The Open CFG file displays the contents of the Comtrade CFG file in an ASCII editor. This will allow for 
viewing or editing the contents of the channel configurations. 

CALCULATED FAULT POSITION 
The system calculates the fault inception when reading the samples values from the file. The fault 
inception is determined by the values entered into the Duration calculations inside the File Manager’s 
Display dialog under the data plotting tab. To show the systems calculated fault inception bar and each 
channels fault inception position, open the Properties dialog inside the data plottting window. Click on the 
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Display Settings tab and select Yes for the Show Calculated Trigger Bar field and select Yes for the Chan 
Fault field. The calculated Fault Bar is position at the first channels calculated trigger. The calculated 
trigger bar is a purple dotted line with a fuschia triangle at the bottom of the bar. Each channels calculated 
poistion is depicted with a red dot.  
 

 
Figure 3.93 Data Plotting Properties Dialog 
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Figure 3.94 Calculated Trigger Position 
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A P P E N D I X  A  

System Keys 
 
This section lists the function keys, cursor keys, and menu buttons available in the file manager, query fields 
and analysis window. 

File Manager 
Function Keys Description 
F1 Display the file table’s help file.  
F2 Display the file, at the cursor position in text format:  ASCII Editor. 
F3 Display the file, at the cursor position in hexadecimal format:  Hex Editor. 
F4 Display a list of the DAU-DEF station titles found in the active directory. 
F5 Display the command line dialog to run an application. 
F7 Change the active path to the specified destination path. 
F8 Copy the marked files to the destination path. 
F9 Move the marked files to the destination path. 
F11 Display a sequence of events table for all the marked waveform files. 
F12 Refresh the folder tree and the current directory 

 
Cursor Keys Description 
Left Arrow Move the cursor bar to the left one position. 
Right Arrow Move the cursor bar to the right one position. 
Up Arrow Move the cursor bar up one position. 
Down Arrow Move the cursor bar down one position. 
Page Up Display the files on the previous page. 
Page Down Display the files on the next page. 
Home  Move the cursor to the first column in the file table. 
End Move the cursor to the last column in the file table. 
Ctrl+Home Move the cursor to the first file in the file table. 
Ctrl+End Move the cursor to the last file in the file table. 
Tab Move the cursor from the file table to the query fields. 
Delete Delete all the marked files and empty directories. 
Enter Run the driver at the cursor position. 
Backspace Change the active path to the previous directory. 
Character keys Move to the next row in the active column that starts with the entered character. 

  
Menu Buttons Description 

    Exit 
Exit Wavewin 

    Help Display the File Manager Help File. 

   About Display the About Window. 

 Tile Horz Tile the open Windows Horizontal. 
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   Tile Vert Tile the open Windows Vertically. 

  Cascade Cascade all the open Windows. 

 Window  Display all of all open Windows. 

  Back Go back to the previous window. 

  Files Open or Bring to Front the File Manager. 

 Folder Tree Show/Hide the Folder Tree. 

   Email Email all the selected files with their support files. 

  Refresh Refresh the folder tree and file manager. 

 Change  Change the Drive or Directory. 

  Up Change the active folder to the parent folder.  

  Back Change the active folder to the last navigated folder. 

  Copy To Copy all selected files to a selected folder using the Microsoft’s Copy dialog. 

  Move To Move all selected files to a selected folder using the Microsoft’s Copy dialog. 

  Mark Mark all or UnMark all files in the File Manager. 

   Query All Query all the file/folders in the File Manager with the entered Query Criteria. 

  Plot 
Plot all the selected file, tile the windows horizontailly then minimize the file 
manager. 

   Edit Edit the file at the cursor position. 

    Summary Display asummary of the transiant file at the cursor position. 

Query Fields 
Function Keys Description 
F1 Display the query help file.  
F5 Query all the marked devices in the active configuration.  
F6 Query all the devices in the active configuration. 
F7 Query all the unmarked devices in the active configuration. 
F8 Clear the query criteria and set all the query operators to “=”. 
F9 Toggle through the available query operators for the active query field. 

 
Cursor Keys Description 
Up Arrow Return the cursor to the device table. 
Right Arrow Move the cursor one position to the right, wraps to next field at the end. 
Left Arrow Move the cursor one position to the left, wraps to next field at the beginning. 
Tab Move the editor to the next query field. 
Shift+Tab Move the editor to the previous query field. 
Enter Process the query criteria for all devices in the active configuration. 

 
Menu Button Description 

 Query Query all devices in the active configuration. 
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Analysis 
Function Keys Description 
F1 Display the data help file.  
F2 Display the analog and digital channel information.  
F3 Generate a max/min peak chart and an EN/SR summary log. 
F4 Toggle between the available analog views. 
F5 Display the software analog channel dialog. 
F6 Turn channel amplitude auto scaling ON or OFF. 
F7 Turn super imposing ON/OFF for all or marked channels. 
F8 Mark or unmark all the visible analog/digital channels. 
F9 Toggle between the available digital views (All or Triggered). 
F11 Display the harmonics table. 

 
Cursor Keys Description 
Left Arrow Move the data bar to the left one sample. 
Right Arrow Move the data bar to the right on sample. 
Ctrl+Right Arrow Move the data bar to the next peak for the first display channel or the first 

marked channel. 
Ctrl+Left Arrow Move the data bar to the previous peak for the first display channel or the first 

marked channel. 
Shift+Ctrl+Right 
Arrow 

Move the data bar ahead one cycle for the first displayed channel or the first 
marked channel. 

Shift+Ctrl+Left Arrow Move the data bar back one cycle for the first displayed channel or the first 
marked channel. 

Shift+Left Arrow Shift the analog information table to the left by one column. 
Shift+Right Arrow Shift the analog information table to the right by one column. 
Page Up Page up through the data. 
Page Down Page down through the data. 
Home Move the data bar to the first data sample. 
End Move the data bar to the last data sample. 
Ctrl+Up Arrow Increase the amplitude for all or marked channels. 
Ctrl+Down Arrow Decrease the amplitude for all or marked channels. 
Ctrl+Page Up Expand the time scale for all visible channels. 
Ctrl+Page Down Condense the time scale for all visible channels. 
Tab Toggle between the analog and digital channels. 
Up Arrow Move the cursor up one channel. 
Down Arrow Move the cursor down one channel. 
Shift+Page Up Display the analog/digital channels on the previous page. 
Shift+Page Down Display the analog/digital channels on the next page. 
Ctrl+Home Display the first page of the analog/digital channels. 
Ctrl+End Display the last page of the analog/digital channels. 
Spacebar Mark or Unmark the channel at the cursor position. 
Shift+Up Arrow Mark or Unmark a group of channels while moving the cursor up. 
Shift+Down Arrow Mark or Unmark a group of channels while moving the cursor down. 
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Insert Display the hidden channels that were removed by the delete keys. 
Delete Hide the marked channels and respace the unmarked channels. 
Enter Hide the unmarked channels and respace the marked channels. 
Esc Display all the hidden channels or exit the data window. 
Backspace Display all the hidden channels. 
+ Shift all the marked channels up one position. 
- Shift all the marked channels down one position. 
Ctrl-A Move the reference bar to the sample at the cursor bar. 
Ctrl-Z Move the RMS bar to the sample at the reference bar. 

 
Menu Buttons Description 

    Exit 
Exit Wavewin 

    Help Display the File Manager Help File. 

   About Display the About Window. 

 Tile Horz Tile the open Windows Horizontal. 

   Tile Vert Tile the open Windows Vertically. 

  Cascade Cascade all the open Windows. 

 Window  Display all of all open Windows. 

  Back Go back to the previous window. 

   Email Email the open file along with it’s support files. 

 Raw Date File Open the raw data file in an ASCII or HEX Editor. 

  Recorder Chans View a lsi of all the analog and digital channels in the waveform file. 

 Summary View the Analog/Digital Summary of the active displayed file. 

 Increase Amp Increase the Amplitude of the marked or all channels. 

 Decrease Amp Decrease the Amplitude of the marked or all channels. 

 ASV Toggle through the available auto scales: ON/OFF/++/Units. 

 Zoom In Condense the time scale of the visible channels. 

 Zoom Out 
Expand the time scale of the visible channels. 

 View Marked Hide the unmarked channels and respace the marked channels. 
 View All Replot all the hidden channels. 

 Properties Display the Window Properties dialog. 

 Select Views  Select a specific line or view from the drop down list. 
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